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Chapter 1 – Using These Instructions 

Audience 

This document is intended for users who are installing or updating to SAS Activity-Based 

Management 7.2. 

Outline 

This document has seven major sections:  

 Deployment Options– Chapter 2 

 Migrating from Previous Versions – Chapter 3 

 Setting Up Users, Groups, and Ports – Chapter 4 

 Installing Third-Party Prerequisites – Chapter 5 

 Installing SAS Prerequisites – Chapter 6 

 Installing SAS Activity-Based Management – Chapter 7 

 Post-Installation – Chapter 8 

Chapter 2, Deployment Options, explains the common configurations that are supported. 

Chapter 3, Migrating from Previous Versions, contains steps for migrating from SAS Activity-

Based Management 6.x, 7.1 or 7.11 to 7.2.  These steps need to be done before you install the new 

version. 

Chapter 4, Setting Up Users, Groups, and Ports, contains an overview of the users and groups 

necessary to install SAS Activity-Based Management. 

Chapter 5, Installing Third-Party Prerequisites, contains steps for installing prerequisite software 

that is not supplied by SAS. 

Chapter 6, Installing SAS Prerequisites, contains the steps for installing other SAS components on 

computers other than the SAS Activity-Based Management Mid-Tier Server. 

Chapter 7, Installing SAS Activity-Based Management, contains the steps successfully installing 

SAS Activity-Based Management 7.2. 

Chapter 8, the Post-Installation, contains steps to create the data sources, perform any desired 

data migration, and test the installation. 

Technical Support 

Please visit the SAS Technical Support web site at http://support.sas.com for installation updates. 

For product documentation please visit the SAS Technical Support Documentation web site 

http://support.sas.com/documentation/onlinedoc/abm/index.html. 

 

Note to the reader:  

Words in examples that are enclosed in angle brackets symbols, <…>, are meant to be replaced by 

information from your system. 

http://support.sas.com/
http://support.sas.com/documentation/onlinedoc/abm/index.html
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For instance, on Windows <SASHOME> should be replaced by the path where you installed SAS.  

If you installed SAS in Program Files on your D drive, then replace <SASHOME> with 

d:\Program Files\SASHOME. 

On UNIX <SASHOME> should be replaced by the path where you installed SAS. If you installed 

the SAS on the /opt path, then replace <SASHOME> with /opt/SASHOME/.  

Likewise, <CONFIGHOME> is the folder name you chose to store your configuration data during 

SAS installation appended with the configuration level that you are currently using. By default 

SAS uses the directory C:\SAS\Config\ for Windows. Most users will use Lev1 for the 

configuration level. Thus a typical value for <CONFIGHOME> is C:\SAS\Config\Lev1. 

So, On Windows the text <CONFIGHOME>\Applications typically evaluates to 

C:\SAS\Config\Lev1\Applications.  

On UNIX <CONFIGHOME> should be replaced by the path where your configuration is installed. 

If you installed the configuration on the /opt path and used a configuration name of Config 

and Level 1, then replace <CONFIGHOME> with /opt/SAS/Config/Lev1. 

Reference Documents 

This installation document is not intended to provide a sufficient knowledge of the SAS software 

installation process to begin installing SAS Activity-Based Management 7.2. The SAS Deployment 

Wizard and SAS Deployment Manager 9.3: User’s Guide is required reading before you begin. It is 

available at 

http://support.sas.com/documentation/installcenter/en/ikdeploywizug/64204/PDF/default/user.p

df 

You also need the minimum supported software versions for SAS Activity-Based Management 

7.2 in order to ensure that any prerequisites you install are compatible with SAS Activity-Based 

Management 7.2. Keep this document handy as it will be referenced repeatedly during the 

installation process. It might be useful to print a copy for quick reference. The SAS Activity-Based 

Management 7.2 System Requirements is available at 

http://support.sas.com/documentation/onlinedoc/abm/index.html. 

SAS Activity-Based Management 7.2 might be the first product at your site that requires SAS 9.3. 

For example, you might be using a 9.1.3-based Metadata Server and Web Report Studio as part of 

your existing SAS Activity-Based Management 7.1 installation. If so, you need to migrate all SAS 

9.2 (or earlier) components to be used by SAS Activity-Based Management 7.2 to 9.3. Please refer 

to the SAS 9.3 Intelligence Platform Migration Guide at 

http://support.sas.com/documentation/cdl/en/bimig/62613/PDF/default/bimig.pdf 

The SAS 9.3 Intelligence Platform Installation and Configuration Guide contains a wealth of 

information on the general process of installing SAS software. It is available at 

http://support.sas.com/documentation/cdl/en/biig/62611/PDF/default/biig.pdf 

Finally, the SAS 9.3 Intelligence Platform: System Administration Guide provides detailed 

information about managing users and groups. It is available at 

http://support.sas.com/documentation/cdl/en/bisag/63132/PDF/default/bisag.pdf 

Release Notes 

Don’t forget to check http://support.sas.com/documentation/onlinedoc/abm/index.html for 

updated documentation in the form of Release Notes. Release Notes contain late-breaking 

information on installation, configuration, and defects. 

http://support.sas.com/documentation/installcenter/en/ikdeploywizug/64204/PDF/default/user.pdf
http://support.sas.com/documentation/installcenter/en/ikdeploywizug/64204/PDF/default/user.pdf
http://support.sas.com/documentation/onlinedoc/abm/index.html
http://support.sas.com/documentation/cdl/en/bimig/62613/PDF/default/bimig.pdf
http://support.sas.com/documentation/cdl/en/biig/62611/PDF/default/biig.pdf
http://support.sas.com/documentation/cdl/en/bisag/63132/PDF/default/bisag.pdf
http://support.sas.com/documentation/onlinedoc/abm/index.html
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One Final Word before You Begin 

Before you begin installing your software, SAS recommends that you disable any antivirus 

software running on your server while doing the SAS installations. On rare occasions, antivirus 

software prevents all necessary files and configurations from completing successfully. 
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Chapter 2 – Deployment Options  

SAS Activity-Based Management supports many different server configurations. Deployment 

architecture is typically chosen based upon the expected workload. First, let’s define a few terms 

to aid with understanding. If you are migrating from the SAS Activity-Based Management 6.x 

and want to change the deployment architecture please contact technical support. 

Mid-Tier Server – This server hosts the SAS Activity-Based Management mid-tier software. This 

includes the SAS Activity-Based Management web services, database access logic, and 

the business rules that provide the activity-based management functionality. This server 

is the “hub” of the SAS Activity-Based Management product. SAS Activity-Based 

Management clients access this server. This server accesses the Database Server and OLAP 

Server to provide model data to the clients. Additionally, it also performs calculation 

tasks on the Calculation Server and creates cubes using the OLAP Server.  

Database Server - This sever hosts the database used by SAS Activity-Based Management to store 

its models. SAS Activity-Based Management 7.2 supports Microsoft SQL Server, MySQL 

and Oracle databases. 

OLAP Server – In general terms, an OLAP server responding to multidimensional query requests 

from an OLAP viewer such as the one built into SAS Activity-Based Management and 

SAS Enterprise Guide. SAS Activity-Based Management supports both the SAS OLAP 

Server and Microsoft SQL Server Analysis Services.  

For purposes of installing and configuring SAS Activity-Based Management, we will 

refer to the OLAP Server as the computer where the SAS PROC OLAP runs or the 

computer where Microsoft SQL Server Analysis Services runs -- not as the computer that 

responds to requests from an OLAP viewer, but instead. This slight distinction is 

necessary because in SAS, cubes can be built on one computer and multidimensional 

query requests handled by a separate computer where SAS OLAP Server is installed. 

In “generic” SAS terminology, this server is typically called a SAS Server. It is so named 

because the SAS installation process installs the entire Base SAS system on this server 

along with specific components needed by SAS Activity-Based Management, such as the 

SAS OLAP Server. However, you may elect to use Microsoft SQL Server Analysis 

Services (SSAS) for OLAP processing, in which case the OLAP Server may not need any 

SAS software. So for brevity, we’ll refer to this logical server as the OLAP Server, even 

though a more appropriate name might be the OLAP Cube Creation Server. 

Calculation Server – This server hosts the SAS Activity-Based Management calculation engine. It 

reads models, performs the necessary calculations, and writes the results back to the 

model database on the Database Server.  

Like the OLAP Server, this server is typically called a SAS Server in installation 

documentation. So if your deployment is using the SAS OLAP Server for cubes, in 

actuality you are installing the same software on two different computers – one used for 

calculation and one used for cube creation. Then during configuration of the SAS 

Activity-Based Management server, you configure these two servers to separate the two 

tasks. Of course, you could install the software on a single computer and configure the 

SAS Activity-Based Management server to perform both tasks on that one computer. 
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Metadata Server – Although referred to as the Metadata Server for discussion purposes, this server 

may host other SAS products or solutions as well. At a minimum, this server hosts the 

SAS Metadata Server, the SAS Web Infrastructure Platform, and the SAS Foundation 

Services. These products are part of the SAS Business Intelligence architecture. SAS 

Activity-Based Management uses it to store information about SAS Activity-Based 

Management users, perform user authentication, and to share data with other 

applications, such as SAS Web Report Studio. It is also used by SAS OLAP Server to store 

cube and security information. Additionally, it centralizes access to SAS Workspace 

Servers, so they can be shared among SAS Business Intelligence applications 

For clarity, this document refers to the five logical servers in italics with their name capitalized to 

distinguish its usage. For example, this document will use Calculation Server when referring to 

your logical deployment; but will use “calculation server” when referring to a specific computer 

or server. 

Now that you have an understanding of what possible logical servers exist, let’s discuss how 

these logical servers may be installed onto physical computers. The SAS Activity-Based 

Management architecture does not specify how the above five Servers map to one or more 

physical computers. You may choose a deployment topology that best suits your needs. The 

topologies discussed below are the most common, but do not enumerate all possibilities. Please 

verify with your SAS consultants the suitability of any of these topologies to your particular 

needs. In order of smallest expected workload to largest, they are:  

Two Computer Deployment  

This deployment is suitable for small installations where:  

1. The number of SAS Activity-Based Management Create Models users and View Models 

users is relatively small.  

2. The SAS Activity-Based Management models and their cubes are small.  

3. Integration with other applications such as SAS Web Report Studio is not needed. 

4. Microsoft SQL Server Analysis Services will be used for OLAP processing.  

All server computers will be operating with the Windows operating system. 

In this deployment, the two server computers host the Servers in the following manner:  

 Server 1: Mid-Tier Server, Metadata Server, and Calculation Server. If your site already has a 

SAS Metadata server installed, SAS Activity-Based Management does not need its own. It 

should share your existing server.  

 Server 2: Database Server and OLAP Server. Alternatively, the Calculation Server could be 

hosted on this computer as well. 

Three Computer Deployment  

This deployment is suitable for mid-size installations. It suits needs similar to the Two Computer 

Deployment discussed above, except the models are now large enough or the number of users is 

large enough that sharing one computer between the Mid-Tier Server and the Calculation Server is 

no longer practical. This deployment is feasible only if the Workspace Server is not heavily used by 

other SAS applications.  

In this deployment, the three server computers host the Servers in the following manner:  
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 Server 1: Mid-Tier Server  

 Server 2: Database Server and OLAP Server  

 Server 3: Metadata Server and the Calculation Server. If your site already has a metadata 

server installed, SAS Activity-Based Management does not need its own. It should share 

your existing server.  

Four Computer Deployment  

This deployment is suited to high-usage installations. It moves the database, OLAP processing, 

and calculation onto separate computers separate from the web application server.  

 Server 1: Mid-Tier Server  

 Server 2: Database Server and OLAP Server  

 Server 3: Calculation Server 

 Server 4: Metadata Server. If your site already has a metadata server installed, SAS 

Activity-Based Management does not need its own. It should share your existing server.  

A SAS workspace server should also be installed on the OLAP server if SAS OLAP Server is used 

to process cubes. This allows the cube creation, cube storage, and cube delivery to be hosted on a 

single computer.  

Five Computer Deployment  

This deployment is suited to very high-usage installations. It moves the database, OLAP 

processing and calculation processing onto computers separate from the Mid-Tier Server.  

 Server 1: Mid-Tier Server  

 Server 2: Database Server  

 Server 3: OLAP Server  

 Server 4: Calculation Server 

 Server 5: Metadata Server. If your site already has a metadata server installed, SAS 

Activity-Based Management does not need its own. It should share your existing server.  

Other Deployment Possibilities 

These deployment options represent a few possible deployment options. Depending on the 

number of SAS Activity-Based Management users at your site, the size of your models, and the 

size of the cubes they generate, other deployment topologies are possible. The key to choosing an 

appropriate topology is to understand the usage patterns and task loading of the computers in 

the deployment.  

Server Prerequisites 

Each of the four logical servers (plus the Metadata Server) in an SAS Activity-Based Management 

deployment has its own specific software prerequisites. Some of these prerequisites are third-

party requirements, such as a relational database, and others are SAS requirements, such as a 

SAS/ACCESS engine for data access. These prerequisites are documented in the SAS Activity-
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Based Management 7.2 Systems Requirements. When logical servers are combined into a single 

physical computer, the prerequisites don’t need to be duplicated – except where explicitly noted.  

Deployment Information 

Record the names of the machines for your deployment. 

Type of Server Machine Name Operating System Machine Description 

Mid-Tier Server     

Calculation Server     

Database Server       

OLAP Server    

Metadata Server    
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Chapter 3 – Migrating from Previous Versions 

This chapter is for use by existing SAS Activity-Based Management 6.x or 7.1 customers or by 

existing SAS 9.2 customers who are new to SAS Activity-Based Management. If neither of these 

two criteria describes your site, you may skip this chapter. 

If you currently use SAS 9.2 or older software then you must update it to SAS 9.3. If you have 

SAS Activity-Based Management 6.x or 7.1 software, then you will follow the steps in this 

document to migrate to SAS Activity-Based Management 7.2. 

Also, if you do not currently have SAS Activity-Based Management of any version installed, you 

cannot migrate your existing SAS 9.2 system to 9.3 and add SAS Activity-Based Management 7.2 

at the same time. If you want to add SAS Activity-Based Management to your installation, you 

should first migrate your existing SAS system to 9.3, then re-run the SAS Deployment Wizard 

(SDW) a second time to add SAS Activity-Based Management 7.2. 

Important Changes from Previous Versions of Activity-Based Management 

There are a few important changes in SAS Activity-Based Management 7.2 that will impact users 

of previous versions of SAS Activity-Based Management: 

 SAS Activity-Based Management 7.2 is incompatible with SAS 9.2. Any other SAS 9.2 

products that you have that SAS Activity-Based Management needs, such as a metadata 

server, must be migrated to 9.3 

 SAS Activity-Based Management 7.2 no longer supports Microsoft SQL Server 2000 or 

2005 databases or Microsoft Analysis Services 2000 or 2005  for OLAP. 

 SAS Activity-Based Management 7.2 no longer supports Oracle 10g database. 

 Cubes generated with SAS OLAP 9.1.3 are incompatible with SAS OLAP 9.3. Thus any 

cubes you have created in previous versions of SAS Activity-Based Management must be 

deleted and recreated in SAS Activity-Based Management 7.2. 

 Cubes built with SAS OLAP Server 9.2 are compatible with SAS OLAP Server 9.3. 

However, the cube names created by SAS Activity-Based Management 7.2 have changed 

from previous versions. This change make the cubes easy to recognize if you access them 

from outside of SAS Activity-Based Management, but also requires that any cubes from 

an older version of SAS Activity-Based Management be deleted and recreated in 7.2. 

If your SAS Activity-Based Management 6.x or 7.1 installation uses Microsoft SQL Server or 

Microsoft Analysis Services 2000 you must update to the Microsoft SQL Server 2008 family of 

products before beginning installation. See the following sections for more details. 

If your SAS Activity-Based Management 6.x or 7.1 installation uses an Oracle 10g database, you 

must migrate to Oracle 11g before beginning installation. Again, see the following sections for 

more details. 

For detailed version information regarding supported third-party tools, please refer to the SAS 

Activity-Based Management 7.2 System Requirements. 

Backing up the System 

Before proceeding you must also backup your database. If you are using Microsoft SQL Server, 

you must backup the OEAdmin (version 6.x only) and OEModels databases (or the names you 

chose for these databases when you installed your “old” version of SAS Activity-Based 
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Management). If you are using Oracle, you must back up the schema you created for SAS 

Activity-Based Management 6.x during the installation.  Before you backup the databases, verify 

that no one is using SAS Activity-Based Management on the server that you are upgrading. 

Warning:  Database backups are specific to a particular version of SAS Activity-Based Management. 

Do not restore the current SAS Activity-Based Management databases from a backup 

created from a previous version.  Include the version number in the backup name. 

Now that you have backed up the SAS Activity-Based Management databases, you should also 

backup the directory that contains the Published Reports that were created by SAS Activity-

Based Management users. This folder is located at:  <SASHOME>\Activity-Based 
Management Solution\Enterprise 

Server\SasSolutions\ABM\Reports\Published. You will restore the contents of this 

directory to a new location during the Post-Installation steps after installation of SAS Activity-

Based Management 7.2 is complete.  

Warning:  Failure to back up the contents of the published reports directory will cause the loss of all the 

published reports created by SAS Activity-Based Management users when the previous 

version of the product is uninstalled in the next step of the upgrade process. 

You should also back up all of your current version SAS data prior to migrating any of the SAS 

components to 9.3. For more information, please refer to the SAS 9.3 Intelligence Platform 

Migration Guide. 

Upgrading from SAS OLAP 9.1.3 

The cubes created in SAS OLAP 9.1.3 cannot be migrated or ported to SAS OLAP 9.3. SAS OLAP 

9.3 introduced numerous enhancements which made converting 9.1.3 cubes to the new format 

impractical. You must recreate the cubes from your SAS Activity-Based Management models 

once your SAS Activity-Based Management 7.2 installation is complete and validated. For more 

information, see “Migrating from SAS OLAP Server 9.1.3” in Appendix D – Third-Party Migration 

for details. For more information please refer to the SAS 9.3 Intelligence Platform Migration Guide. 

Upgrading from SAS OLAP 9.2 

Cubes built with SAS OLAP Server 9.2 are compatible with SAS OLAP Server 9.3. However, the 

cube names created by SAS Activity-Based Management 7.2 have changed from previous 

versions. This change make the cubes easy to recognize if you access them from outside of SAS 

Activity-Based Management, but also requires that any cubes from an older version of SAS 

Activity-Based Management be deleted and recreated in 7.2. For more information please refer to 

the SAS 9.3 Intelligence Platform Migration Guide. 

Upgrading from Microsoft Analysis Services 2000 or 2005 

If you currently use Microsoft Analysis Services 2000 (MSAS) or 2005 (SSAS) and are updating to 

SQL Server Analysis Services 2008 (SSAS), you cannot migrate your MSAS cubes to SSAS. The 

existing cubes must be deleted and re-created on SSAS. For more information, see Appendix D – 

Third-Party Migration for details. 

Upgrading from Microsoft SQL Server 2000 or 2005 

Data from Microsoft SQL Server 2000 or 2005 can be moved to Microsoft SQL Server 2008. See 

“Migrating from SQL Server 2000 or 2005” in Appendix D – Third-Party Migration for details. 
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Upgrading from Oracle 10g 

There are several ways to upgrade to Oracle 11g if you currently use an older version. Please visit 

Oracle’s website at 

http://www.oracle.com/technology/products/database/oracle11g/upgrade/index.html for detailed 

information. 

Running the SAS Migration Utility 

Follow the instructions in the SAS 9.3 Intelligence Platform Migration Guide for migrating your 

existing SAS 9.1.3 or 9.2 Intelligence Platform. 

Once you have migrated your SAS Business Intelligence Platform to 9.3, continue with these 

instructions to complete your installation. Once the software installation is complete, the final 

step of the installation process will migrate your existing SAS Activity-Based Management data 

to the new 7.2 format. If your existing version is 6.x, some additional manual steps must be 

performed. These steps are covered in Chapter 8. 

http://www.oracle.com/technology/products/database/oracle11g/upgrade/index.html
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Chapter 4 – Setting Up Users, Groups, and Ports 

Before you install your software, you must have a user account available to install the SAS 

software. The following sections explain how to create the necessary user accounts and groups on 

the operating system as well as setting the permissions for them. 

Additionally, you need an understanding of the ports used by SAS Activity-Based Management 

and its third-party prerequisites. 

Warning: While reading this chapter, please be aware that using “local” users (i.e. users that are 

defined on a local computer and do not have network or domain authentication, in Windows 

terminology) for tasks other than software installation can cause many authentication 

problems when software is deployed on more than one computer. These problems arise 

because a local user on one computer is “invisible” to software on another – even if the same 

user accounts are created with identical passwords on each computer. If resources and access 

privileges on one computer need to be authenticated on another computer, that user must 

have network authentication.  

The following sections describe the user accounts that SAS and third-party software require, and 

provide information to help you understand the answers to these questions: 

 What are internal and external user accounts? 

 What user rights or to what groups must each account be assigned? 

 Should I create local or network directory service accounts? 

Types of Accounts 

There are two types of user accounts to understand when deploying SAS:   

 Internal user accounts are accounts known only to SAS and are created and authenticated 

internally in metadata rather than externally via an operating system.  

 External user accounts are user accounts defined outside of SAS metadata. These accounts 

are local to a machine or are defined in a network directory service of which the machine 

is a member, such as LDAP. 

Internal Accounts 

Internal user accounts are accounts known only to SAS and are created and authenticated 

internally in metadata rather than externally. SAS identifies internal accounts by appending a 

special string to the user ID. This special string begins with an “at sign” (@) and contains the 

characters saspw. For example: @saspw. For two of the required user accounts, the SAS 

Administrator and the SAS Trusted User, the SAS Deployment Wizard prompts you by default to 

create internal user accounts.  

You will not need access to these two internal accounts for day-to-day usage of SAS Activity-

Based Management. However, you will need them to administer your SAS Activity-Based 

Management installation.  

For more information on internal accounts, see “Understanding the State of Your System” in the 

SAS Intelligence Platform: System Administration Guide. 
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External Accounts 

External user accounts are user accounts defined outside of SAS metadata. These accounts are local 

to a machine or are defined in a network directory service of which the machine is a member, 

such as LDAP or a Windows domain. SAS requires certain external user accounts for two 

purposes: installation and running certain SAS server processes. During installation and 

configuration, the SAS Deployment Wizard must run under an external account with the 

necessary privileges on the target computer to write SAS program and log files. To run servers 

such as the stored process server and the pooled workspace server, SAS requires an external user 

account to be the server process owner. For more information about external user accounts and 

their purposes, see the SAS Intelligence Platform: System Administration Guide. 

As you create these external user accounts, record information about them in the table provided. 

You will need this information when you run the SAS Deployment Wizard to install SAS 

Activity-Based Management and other SAS software. 

Accounts Summary 

The key points to remember are: Some discussions that follow in this document refer to internal 

accounts and some that refer to external accounts. When referring to internal accounts or groups 

it implicitly means items in a SAS metadata server. When referring to external accounts or groups 

it implicitly means items in an operating system. 

Calculation Server and OLAP Server Accounts 

The external accounts and external groups discussed in this chapter must be accessible on the 

SAS Activity-Based Management Calculation Server and, if you are using SAS OLAP Server, on 

your OLAP Server as well. 

They are also required on other SAS servers in your deployment, but will not be needed on your 

database server, nor will they be needed on your OLAP Server if you are using Microsoft SQL 

Server Analysis Services. 

Creating External User Accounts 

SAS Activity-Based Management needs an external account for: 

 the software installer 

 each SAS Activity-Based Management user, or at least one for a First User 

Other SAS software also needs an external account to run the SAS Spawned Servers. However, 

SAS Activity-Based Management does not use SAS Spawned Servers, so that account can be 

ignored for the purposes of installing SAS Activity-Based Management.1  

You may install your SAS software using any operating system account that has sufficient 

privileges. However, SAS recommends that you use the same user to install all SAS software, all 

third-party prerequisite software, to uninstall software, and to apply any required software 

updates.  

Please document the account IDs you use in the table below. 

                                                           

1 Do not confuse the SAS Spawned Server with the SAS Object Spawner. 
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Account 
4
 Recommended User ID Actual User ID 

SAS Installer 
Windows: my-domain\installer-id1  

UNIX: sas 2, 3  

1 On Windows, the user ID should be available in the future to facilitate SAS maintenance. 

2 On AIX, make sure that the User can LOGIN? setting is set to true for the user. 

3 On UNIX, do not use root. 

4 For information about the user accounts see “Rights Required by External User Accounts for SAS” in 

SAS 9.3 Intelligence Platform: Installation and Configuration Guide. 

Operating systems require that you assign certain rights to the external user accounts used to 

deploy and to run SAS. The following table describes the user rights needed by the required 

external user accounts to deploy and run SAS. 

Account Operating System User Rights Needed 

SAS Installer 

Windows Administrator rights 

UNIX 
Member of a group that is the primary 

group for the SAS Spawned Servers 

account1 

1 SAS Activity-Based Management does not use any SAS Spawned Servers accounts. However, other 

SAS products may. If you do create a spawned servers account, it must also be a member of a group 

that is the primary group for the SAS Installer account. 

On Windows, if you choose how to run your SAS servers using management scripts—instead of 

running them as Windows services—then the user account that runs the SAS Spawned Server 

must meet the following requirements on the Spawned Server machine: 

 be the administrator or a member of the Windows Administrator’s group 

 have the following Windows local user rights: 

o Adjust memory quotas for a process 

o Replace a process level token 

When you set up passwords for your SAS system users, SAS recommends that these passwords 

not have to be reset on first log-on. It is also preferable that the passwords for these accounts do 

not expire.  

Windows 

On a Windows 2003 Server, follow these steps if you need to create a local SAS Installer User. If 

you already have a local account for this purpose or if you plan to use a network account, skip 

these steps. Otherwise, you need to create this local user on each computer where SAS software 

will be installed: 

1. Start Control PanelAdministrative ToolsComputer Management.  

2. Expand the System Tools. 

3. Expand Local Users and Groups and right-click Users. Select New User… 

4. Fill in the user name for the installation user name you chose. 

5. Fill in the descriptions (SAS Installer User) and password. 

6. Deselect User must change password at next logon. 

7. Select User cannot change password. 
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8. Select Password never expires. 

9. Click Create. 

10. Click Close. 

UNIX 

Use the appropriate system utilities to add a user with the following characteristics. 

 Add a user (AIX is mkuser and Solaris is useradd) 

 Set its password (passwd <NewUser>) 

 Set the expiration date to 99999 (AIX is chuser –a and Solaris is usermod) 

SAS First User Account (Optional) 

To validate your SAS deployment, you need an external user account that is representative of an 

SAS Activity-Based Management user. This account must be the temporary process owner when 

its jobs are run on a standard workspace server. This user is typically an SAS Activity-Based 

Management user whose account will be used to validate the installation. However, you may 

optionally create a temporary external account whose sole purpose is validation. If you so choose, 

the SAS Deployment Wizard can create an internal SAS First User account for you and prompt 

for the First User’s external account’s credentials.  

Creating External Groups 

It is necessary that the proper operating system privileges are granted to users who will run SAS 

processes. This must be done on each computer where these processes will run. SAS Activity-

Based Management users who perform calculations need the ability to launch batch processes on 

the Calculation Server and, if you are using SAS OLAP Server, users who create cubes need the 

ability to launch batch processes on the Calculation Server and the OLAP Server as well. 

On UNIX and Windows, adding users to a group and then granting that group the proper 

permissions simplifies managing multiple users. 

Full name Recommended Group ID Actual Group ID 

SAS Server Users 
Windows: SAS Server Users  

UNIX: sas  

 

Windows 

Create a new external group (not a metadata server group) and add each SAS Activity-Based 

Management user to the group of SAS server users. If you are creating a SAS First User account, 

add it to this group as well. 

Warning:  Failure to add each SAS Activity-Based Management user to the group of SAS server users 

on the necessary computers will cause calculation and cube generation tasks to fail. 

The steps should be performed on each computer in your deployment where you will install SAS 

software. For a typical SAS Activity-Based Management installations this means the Calculation 

Server and the OLAP Server, if SAS OLAP is used: 

1. Open StartControl PanelAdministrative ToolsComputer Management.  
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2. Expand Systems Tools. 

3. Expand Local Users and Groups and right-click Groups. Select New Group… to create a 

new group using the SAS Server Users name you chose. Networked user accounts are 

needed if the metadata server is on a separate machine from the other SAS Servers. 

4. Close Computer Management. 

 

Finally, grant Log on as a batch job to this group. 

1. Bring up the Local Security Settings dialog by double-clicking Administrative 

ToolsLocal Security Policy in the Control Panel. 

2. Select Local PoliciesUser Rights Assignment. 

3. Right-click Log on as a batch job and select Properties. 

 

4. Click Add User or Group. The Log on as batch Properties dialog displays. Select the 

Add User or Group button.  

5. The Select Users or Groups dialog displays. The dialog does not search for groups on the 

local computer by default. Select the Object Types button.  

 

6. The Objects Types dialog displays. Make sure that the Groups check box is selected and 

click OK. Select the Locations button. The Locations dialog displays.  

7. Make sure the your local computer name is selected. The local computer name is usually 

displayed at the top of the list. Click OK. 

8. Type your SAS Server Users name in the Enter the object names to select entry box. 

Select Check Names. Click OK to close the Select Users or Groups dialog. 

9. Click OK to close the Log on as batch Properties dialog. 

UNIX 

If you are installing any SAS software on a UNIX system, you need to create a UNIX group to 

hold the ID of the SAS Server User. SAS recommends that you name this group sas. The system 

command for creating a group on AIX is mkgroup and on Solaris is groupadd. The system 

command to add members is useradd –G <GroupName> <UserName>. 
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Designating Ports 

About Ports and Multicast Addresses 

You also need to review the set of ports that the SAS servers and third-party servers in your 

system will use by default. If any of these ports are unavailable in your environment, perhaps 

due to port conflicts with other software, select an alternate port and record the new port on the 

following ports pre-installation table. 

You also need to plan for designating Internet Protocol (IP) multicast addresses for the all the 

machines in your SAS deployment. This topic is beyond the scope of installing SAS Activity-

Based Management. For more information please see “Setting Up Users, Groups, and Ports” in 

the SAS 9.3 Intelligence Platform Installation and Configuration Guide. 

This is not a complete list of the ports used by SAS products. It is a list of the ports that will be 

used by SAS Activity-Based Management. For more information on ports, please refer to 

“Designating Ports and Multicast Addresses” in the SAS 9.3 Intelligence Platform Installation and 

Configuration Guide. 

Server 
Default 

Port 

Actual 

Port 
Machine Name 

Mid-Tier Server (choose one): 

 JBoss 

 Oracle WebLogic 

 IBM WebSphere  

 

8080 

7001 

9080 

  

Database Port (choose one): 

 Microsoft SQL Server 

 Oracle 

 MySQL 

 

14333 

15213 

33063 

  

OLAP Server Port (choose one): 

 Microsoft SQL Server Analysis Services 

 SAS OLAP Server1 

 

N/A 4 

5451 

  

SAS Metadata Server  8561   

SAS Workspace Server2 8591   

SAS Deployment Tester Server 10021   

SAS Activity-Based Management “Operations” 5081   

SAS Activity-Based Management “Windows Service Port” 9050   

SAS Foundation Services5 5091   

1 This port is for the Workspace server on the OLAP Server (if SAS OLAP Server is being used) 

2 This port is for the Workspace server on the Calculation Server 

3 This is the default port for the default instance. If you create a named instance, the port may differ 

4 Microsoft SQL Server Analysis Services does not use a port for creating connections 

5 This is usually located on the Metadata Server 

The default port assignment is based upon a clean installation of the product on a computer 

where there are: 

 no other instances of that product installed 

 no other versions of that product running 

 no other products of a similar nature are running (e.g. web servers) 
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If any of the above is true, then the default ports may have been reassigned during the 

installation of the product. Pleases verify the proper port assignment before continuing with the 

SAS Activity-Based Management installation. 

Warning: There cannot be any conflicting port assignments on any single computer. SAS port 

assignments may be duplicated across computers as the connection between 

components/services on different computers is formed using the computer name and the port 

number. 
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Chapter 5 – Installing Third-Party Prerequisites 

This chapter provides an overview for the installation of the third-party software prerequisites 

that will be needed by the SAS Activity-Based Management installation. These instructions are 

not intended to replace the OEM instructions for the software, but are instead intended to 

provide an overview for important options and installation choices that SAS Activity-Based 

Management relies on for proper operation. 

Important: Not all of these prerequisites are required on all servers. Please follow the instructions 

carefully to minimize installing unnecessary software. 

Before installing the SAS Activity-Based Management software on the Mid-Tier Server, please 

verify that the other Servers in your deployment have the proper third-party software 

prerequisites and SAS software prerequisites installed on them. Please record the following 

information during the installation process for reference purposes: 

 computer names 

 newly created user accounts and passwords 

 installation directories (for certain items where this is needed later) 

 a check-mark that the software has been installed 

Please verify that you are installing these prerequisites using the proper SAS Installer user that 

was identified in the previous chapter. 

This information is needed to configure the SAS Activity-Based Management server so it can 

properly communicate with the other servers. Use the tables below to record the information as 

your installation proceeds: 

Mid-Tier Server – Machine Name: 

Prerequisite Software Installed? Installation Directory 

SAS Activity-Based Management Mid-Tier
1
   

Java 2 SDK   

Web Application Server Software   

Database access software
2
   

JUnit Software   

Microsoft .NET
3
   

1 To be installed in Chapter 7 

2 Either a JDBC driver for SQL Server or Oracle or the MySQL Connector/J for a MySQL database. The 

Installation Directory is important only if you are using MySQL 

3 .NET is only needed if you are using SQL Server Analysis Services for OLAP 

 

Database Server – Machine Name: 

Prerequisite Software Installed? Instance/GDB Name 

Relational Database    

 

http://www.mysql.com/products/connector/j/
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OLAP Server (if using SAS OLAP Server 1) – Machine Name: 

Prerequisite Software Installed? 

SAS Activity-Based Server Tier
3
  

Database access software
2
  

1 Includes Base SAS with PROC OLAP, SAS OLAP Server, and Workspace Server 

2 An ODBC driver for SQL Server, Oracle, or MySQL database. 

3 The full name is SAS Activity-Based Management Data Integration and Enterprise BI Server. This will be 

installed in Chapter 7. This can also be any existing SAS OLAP Server 

 

 

OLAP Server (if using SQL Server Analysis Services 1) – Machine Name: 

Prerequisite Software Installed? 

SQL Server Analysis Services  

Database Connectivity Tools
1
  

1 Either Microsoft Client Connectivity Tools or Oracle Client Tools  

 

Calculation Server – Machine Name: 

Prerequisite Software Installed? 

SAS Activity-Based Costing Server
1
  

Database access software
2
  

SAS/ACCESS to ODBC  

SAS/ACCESS to Oracle (if using an Oracle 

database) 

 

SAS/ACCESS to MySQL (if using a 

MySQL database) 

 

1 Includes Base SAS with PROC ABC, SAS/GRAPH, and Workspace Server as key components 

2 The Microsoft Client Connectivity Tools for SQL Server; Oracle Client Tools; or an ODBC driver for 

MySQL.  

 

Metadata Server – Machine Name: 

Prerequisite Software Installed? Internal Account Password 

SAS Metadata Server    

SAS Foundation Services    

 

These prerequisites must be installed before you install SAS Activity-Based Management or, if 

they are to be installed on the same computer as SAS Activity-Based Management, they can be 

installed simultaneously. 

User ID for Installations 

Make sure you are logged in as the SAS Installer User before proceeding.  
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Java JDK for Servers 

Warning: SAS does not support ”mixing” 32 bit SAS software and 64 bit SAS software on 64 bit 

Windows computers. If you have a 32 bit version of Windows, then install 32 bit software. If 

you have a 64 bit version of Windows, then install 64 bit software or install 32 bit software 

– but don’t mix the two environments. For example, don’t try to install a 32 bit version of 

SAS Foundation and a 64 bit Java JDK.  

The Java JDK is a required prerequisite for the Mid-Tier Server in your deployment. The version of 

the Java JDK you need depends on the web application server you are using. Please refer to the 

SAS Activity-Based Management 7.2 System Requirements for the specific version for your web 

application server. 

Once you have installed the correct JDK and you provide the correct path of this JDK to the SAS 

Deployment Wizard, no additional configuration should be needed. SAS launches the correct 

JVM using the full path you provide. 

Windows 

Install the JDK appropriate for your operating system & web application server. 

Warning: The SAS Deployment Wizard prompts for a JRE and a JDK. The JRE is used only by the 

SDW and its configuration utilities. This JRE must be a 32 bit JRE if you are installing on a 

64 bit version of Windows. The JDK is used to run the rest of the SAS software that is 

installed. When prompted for the JRE, SAS recommends that you select the option to allow 

the SAS Deployment Wizard to install its own JRE. This ensures the installation and 

configuration process will complete successfully. 

UNIX 

Install the JDK appropriate for your operating system & web application server. 

The following commands set the PATH environment variable on UNIX. These statements can be 

added to the .profile file of the user that is running the installation. Alternatively this can be 

added to a common profile accessed by the user’s profile. 

For example if you installed Java JDK 1.6.0_24 in the usr directory, issue the following 

commands: 

PATH=$PATH:/usr/jdk1.6.0_24 

export PATH 

Web Application Server 

A web application server is a required prerequisite for the Mid-Tier Server in your deployment. 

SAS Activity-Based Management 7.2 needs a web application server installed on the Mid-Tier 

Server. You must pick one of the following web application servers and install it before you install 

SAS Activity-Based Management 7.2. 

 JBoss or 

 Oracle WebLogic or 

 IBM WebSphere ND 

Please note that not all applications servers are supported on all platforms. See the SAS Activity-

Based Management 7.2 System Requirements document for the minimum level of the web 
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application server for the operating system of your Mid-Tier Server and on which operating 

systems they are supported. 

Verify that the assigned port is available for the particular web server so that it can properly 

respond to HTTP requests without conflicting with other Web servers. If the assigned port is not 

available you will need to resolve the conflict by changing one port used by one of the conflicting 

applications.  If you need to change the port, then you will need to make changes in the 

application manager for the applications that use this web application server. 

JBoss 

Note: SAS supports JBoss EAP (the commercial version) and JBoss AS (the community version) 

as web application servers for SAS products. However, SAS has support limitations for the 

AS version which is documented here: 

http://support.sas.com/resources/thirdpartysupport/jbossSupport.html 

Install JBoss on the computer you identified as the Mid-Tier Server in your deployment. JBoss 

does not have a traditional installation process. You only need to un-zip/un-tar it into the 

directory of your choice. You must contact RedHat to obtain a license for this web application 

server if you do not already own one. Please refer to SAS’ detailed instructions at 

http://support.sas.com/resources/thirdpartysupport/v93/appservers/jbossdoc.html.  

Oracle WebLogic  

Install Oracle WebLogic on the machine hosting the SAS Activity-Based Management Server 

Application.  You must contact Oracle to obtain a license for this web application server if you do 

not already own one. Please refer to SAS’ detailed instructions at 

http://support.sas.com/resources/thirdpartysupport/v93/appservers/weblogicdoc.html.  

IBM WebSphere 

Install IBM WebSphere on the machine hosting the SAS Activity-Based Management server. You 

must contact IBM to obtain a license for this web application server if you do not already own 

one. Please refer to SAS’ detailed instructions at 

http://support.sas.com/resources/thirdpartysupport/v93/appservers/webspheredoc.html.  

After Installing JBoss, WebLogic, or WebSphere  

All Web Application Servers 

After completing the installation of the web application server, it may need additional 

configuration to optimize its performance or to ensure its compatibility with SAS software. Please 

read the post installation steps for your web application server at 

http://support.sas.com/resources/thirdpartysupport/v93/appservers/index.html. All the 

documentation that refers to SAS 9.3 is applicable. 

Warning: You must read and follow the instructions for your web application server. Some of the 

instructions refer to specific configuration settings required by SAS products; others refer to 

specific software patches that must be installed on your web application server due to specific 

defects found by SAS; still others refer to optimization techniques to maximize performance 

for SAS software.  

Warning: Failure to follow these instructions before proceeding may result in installation failures later 

during SAS software installation. 

http://support.sas.com/resources/thirdpartysupport/jbossSupport.html
http://support.sas.com/resources/thirdpartysupport/v93/appservers/jbossdoc.html
http://support.sas.com/resources/thirdpartysupport/v93/appservers/weblogicdoc.html
http://support.sas.com/resources/thirdpartysupport/v93/appservers/webspheredoc.html
http://support.sas.com/resources/thirdpartysupport/v93/appservers/index.html
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Relational Database  

A relational database is a required prerequisite for the Database Server in your deployment. 

The SAS Activity-Based Management 7.2 Solution needs a relational database to store it data. You 

need to select one of the following databases and install it.  

 Microsoft SQL Server  database (for Windows) or 

 MySQL database (for Windows and UNIX) or 

 Oracle database  (for Windows and UNIX) 

If you have already installed a database, please verify the port number for the database and 

record it in the table in the previous chapter.   

Use this table to record the installation details for the database. 

Database user name Password Database/Schema name 

    

 

Installing Microsoft SQL Server Database 

You may skip this section if you are upgrading from a previous version of SAS Activity-Based 

Management and if you are using a version of SQL Server that is supported by SAS Activity-

Based Management 7.2. However, you will need the SQL Server user’s name, password, and the 

database name that contains your existing data. Please record this information in the table above. 

You will need it later when you install SAS Activity-Based Management 7.2 and when you 

update your database to the SAS Activity-Based Management 7.2 schema format. 

Background 

Microsoft has changed terminology over the last several releases of SQL Server. In SQL Server 

2000, the OLAP server was named Microsoft Analysis Services (MSAS) but in SQL Server 2008 

(and 2005) it is called SQL Server Analysis Services (SSAS). This should not be confused with SAS 

OLAP Server.  

Also, in SQL Server 2000 the connectivity drivers (ODBC, OLEDB, etc.) and management console 

were combined together into the Client Tools installation. In SQL Server 2008 (and 2005) the 

connectivity tools are part of the renamed Workstation Components installation. In SQL Server 

2008 the connectivity tools are a separate installation option and are part of Client Tools 

Connectivity. The SQL Server Management Studio is part of Management Tools in SQL Server 

2008. Please keep these changes in mind when installing SQL Server as the names of the required 

options have changed. 

Important:  If you are using Microsoft SQL Server for your database or Microsoft SQL Server Analysis 

Services for your OLAP processing, your Mid-Tier Server must be on Windows. This is a 

configuration limitation is due to user authentication limitations between UNIX and 

Windows. 

Install Microsoft SQL Server 2008 

Complete the installation steps in “Installing Microsoft SQL Server 2008” in Appendix A. 
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Configure Microsoft SQL Server 2008 

Complete the configurations steps in “Configuring Microsoft SQL Server 2008” in Appendix A. 

Install Oracle Database  

Warning: The Oracle installer performs a few prerequisite tests. Make sure all tests successfully 

complete. If any tests fail, refer to the Oracle installation guide for help. This is especially 

important because depending on your hardware configuration, the Oracle database may 

require the presence of a Loopback Adapter for proper operation. If the Loopback Adapter is 

not installed but its presence is required by Oracle, the Oracle database will appear to 

operate properly most of the time. However, SAS has determined that random failures, 

typically involving “concurrency” (to quote the Oracle error messages), will occur. The 

Oracle documentation has instructions for installing the Loopback Adapter on your 

operating system. 

Complete the installation and configuration steps in “Installing Oracle 11g” in Appendix B. 

Install MySQL Database 

Install MySQL on the machine you identified as the Database Server in your topology. You can 

download the community edition of their software from the MySQL website at   

http://dev.mysql.com/downloads. 

If the MySQL database is not on the web application server computer, you may want to install 

the MySQL GUI Tools Bundle on the web application server computer for convenience. 

Detailed instructions for installing and configuring the MySQL database are available in 

“Installing MySQL” in Appendix C.  

OLAP Server 

If you are using SAS OLAP Server, you may skip this section. You will install it in Chapter 6. 

If you are using Microsoft SQL Server Analysis Services, you should install it on the computer 

you have identified as the OLAP Server in your SAS Activity-Based Management deployment. If 

you are using Microsoft SQL Server Analysis Services and your OLAP Server and Database Server 

are deployed on one computer, then you may have already installed the OLAP software. If so, 

you can skip this section. 

Microsoft SQL Server Analysis Services 2008 

See “Installing Microsoft SQL Server Analysis Services” in Appendix A. 

ODBC Drivers 

The Calculation Server uses the ODBC drivers to access the database. Likewise, if you are using 

the SAS OLAP Server to create SAS Activity-Based Management cubes, the OLAP Server 

deployment also uses the ODBC drivers to access the database. If your Calculation Server or OLAP 

Server is on a 32 bit operating system you need a 32 bit ODBC driver. If your Calculation Server or 

OLAP Server is on a 64 bit operating system you need a 64 bit ODBC driver. This is true 

regardless of the operating system or the “bit-ness” of the operating system on your Database 

Server. 

http://dev.mysql.com/downloads
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If you are using Microsoft SQL Server Analysis Services to create SAS Activity-Based 

Management cubes, then the OLAP Server does not need ODBC drivers, but it does need the 

Client Connectivity tools for your database.  

Important:  SAS recommends installing the ODBC drivers using the Client Connectivity Tools options 

on your database installation CDs for Microsoft SQL Server and Oracle databases. This 

guarantees that the Calculation Server, and hence the ODBC drivers, will receive any 

updates as part of a database update provided by your vendor. 

Important:  Windows distinguishes between 32 bit ODBC drivers and 64 bit ODBC drivers. Windows 

also distinguishes between 32 bit DSNs and 64 bit DSNs. 32 bit DSNs can only use 32 bit 

ODBC drivers and 64 bit DSNs can only use 64 bit ODBC drivers. 

Microsoft SQL Server Database 

If you  need to download the drivers directly, look for the “Microsoft SQL Server Native Client” 

for SQL Server 2008 at 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=b33d2c78-1059-

4ce2-b80d-2343c099bcb4  

Oracle Database 

If you need to download the ODBC drivers directly, the “Oracle Data Access Components” for 

Oracle 11g can be found at 

http://www.oracle.com/technology/software/tech/windows/odpnet/index.html. 

Important:  If your Calculation Server is installed on a UNIX computer, you may not be able to 

download ODBC drivers for your Oracle database free of charge. For more information, 

contact Oracle Technical Support. 

MySQL Database 

If you need to download the ODBC drivers directly they can be found at: 

http://www.mysql.com/downloads/connector/odbc. 

JUnit for SAS Activity-Based Management Server Diagnostic 

JUnit must be installed on the Mid-Tier Server. SAS Activity-Based Management Server 

Diagnostic needs access to JUnit 4.8.1 software to run. It can be installed from the SAS Support 

web site at  http://support.sas.com/resources/thirdpartysupport/v93/othersw.html#tab_junit . 

Select the JUnit link at the top of the page and then select the Download link. Install it on the 

Mid-Tier Server. 

Required Software for SAS Activity-Based Management Surveys 

Adobe Flash Player   

The SAS Activity-Based Management Surveys web client requires that Adobe’s Flash Player be 

installed on any computer where you want to access the Surveys tool. SAS supports the Adobe 

Flash Player versions 10.1 and 10.3. You can download these from Adobe’s website at: 

http://get.adobe.com/flashplayer. 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=b33d2c78-1059-4ce2-b80d-2343c099bcb4
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=b33d2c78-1059-4ce2-b80d-2343c099bcb4
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html
http://www.mysql.com/downloads/connector/odbc/
http://support.sas.com/resources/thirdpartysupport/v93/othersw.html#tab_junit
http://get.adobe.com/flashplayer
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Required Software for SAS Activity-Based Management Client 

The following software is required for each SAS Activity-Based Management client.  

Adobe Reader   

SAS Activity-Based Management client optionally creates reports in Adobe’s Acrobat format. To 

view these reports you need an Adobe Reader. You can download this from the Adobe website 

at: http://get.adobe.com/reader.  

Adobe Flash Player   

The SAS Activity-Based Management Surveys web client has a special set of software 

prerequisite requirements. See the section above entitled Required Software for SAS Activity-Based 

Management Surveys for more information. 

Microsoft .NET Framework 

The Microsoft .NET 3.5 SP1 and 4.0 Frameworks are required by the SAS Activity-Based 

Management client.  The .NET 3.5 Framework typically comes preinstalled as part of Windows 7, 

so a separate installation should not be required. 

The Microsoft .NET Framework may be downloaded from 

http://www.microsoft.com/downloads. 

Microsoft Internet Explorer 

Microsoft Internet Explorer is typically installed as part of the Windows operation system and 

usually doesn’t need to be separately installed. 

Important:  The SAS Activity Based Management client is a 32 bit application. It runs properly on 

either 32 bit or 64 bit versions of Windows. However, it uses the 32 bit version of Internet 

Explorer even when running on a 64 bit version of Windows. 

DHTML Editing Control for Microsoft Internet Explorer 

If your SAS Activity Based Management client is running on Microsoft Vista or Microsoft 

Windows 7 operating system, you may need to install the DHTML Editing Control for 

Applications on your client computer. This control is installed by various Microsoft products 

including Microsoft Office 2007. However, if you have a new computer with no additional 

Microsoft software installed you can download the Editing Control from Microsoft’s website at 

http://www.microsoft.com/downloads/details.aspx?familyid=b769a4b8-48ed-41a1-8095-

5a086d1937cb&displaylang=en  

Important:  If your client computer does not contain a properly installed version of this control, you will 

not be able to view OLAP cubes. 

Microsoft XML Core Services 

Microsoft XML 6.0 Parser is installed as part of Microsoft Internet Explorer and does not typically 

need to be installed separately. 

If necessary it can be downloaded from 

http://www.microsoft.com/downloads/details.aspx?FamilyId=59914795-60c7-4ebe-828d-

f28cb457e6e3&displaylang=en . 

http://get.adobe.com/reader
http://www.microsoft.com/downloads
http://www.microsoft.com/downloads/details.aspx?familyid=b769a4b8-48ed-41a1-8095-5a086d1937cb&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=b769a4b8-48ed-41a1-8095-5a086d1937cb&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=59914795-60c7-4ebe-828d-f28cb457e6e3&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=59914795-60c7-4ebe-828d-f28cb457e6e3&displaylang=en
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OLEDB for OLAP Drivers 

In order for your client computer to properly display OLAP cubes you need a driver to allow it to 

access OLAP data sources. 

If you are using SAS OLAP Server to create cubes, then you need the SAS OLEDB for OLAP 9.3 

driver. This driver is included as part of the SAS Activity-Based Management Client installation 

and is not normally installed separately. 

If you are using Microsoft SQL Server Analysis Services 2008, then you need the Microsoft 

OLEDB for OLAP 10.0 driver available from 

http://www.microsoft.com/downloads/details.aspx?FamilyId=C6C3E9EF-BA29-4A43-8D69-

A2BED18FE73C&displaylang=en . 

Special Combinations 

Oracle WebLogic and MySQL Database 

The Oracle WebLogic web application server ships with an older MySQL Connector/J version 

than SAS Activity-Based Management requires. To resolve this problem after WebLogic is 

installed, delete the file <WEBLOGIC_HOME>\server\lib\mysql-connector-java-

commercial-5.0.3-bin.jar. Then make sure you have installed the correct version of the 

MySQL Connector/J driver and that you specify the location of the correct version to the SAS 

Deployment Wizard later in this document. 

Warning:  Unfortunately, since Oracle WebLogic chose to redistribute a version of the MySQL 

Connector/J jar files in this manner, updating this jar file on your WebLogic installation will 

impact all products that share this installation. Most other SAS solutions have been 

validated to use this newer version. However, if you are uncertain about compatibility with 

other SAS products please contact SAS Technical Support before proceeding. 

Windows MySQL Database 

The MySQL database needs additional configuration of the Windows computer that hosts it. You 

must create two registry entries that alter the behavior of the TCP/IP connection. These settings 

are discussed in greater detail in Appendix B of the MySQL instruction manual in the section 

entitled “Errors, Error Codes, and Common Problems”. 

Warning: The following procedure involves modifying the Windows registry. Before you modify the 

registry, make sure to back it up and make sure that you understand how to restore the 

registry if a problem occurs. For information about how to back up, restore, and edit the 

registry, view the following article in the Microsoft Knowledge Base: 

http://support.microsoft.com/kb/256986/EN-US/.  

1. Open the Windows Registry Editor by selecting StartRun…. When the Run dialog 

displays, enter regedit and click OK. 

2. Go to 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters 

3. Right-click on the Parameters folder and select NewDWORD Value. 

4. Enter the key name MaxUserPort. Double-click on the MaxUserPort key.  

5. The Edit DWORD Value dialog displays. Change the Base to Decimal. Enter 65534 as 

the Value Data. Close the Edit DWORD Value dialog by clicking OK. 

http://www.microsoft.com/downloads/details.aspx?FamilyId=C6C3E9EF-BA29-4A43-8D69-A2BED18FE73C&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=C6C3E9EF-BA29-4A43-8D69-A2BED18FE73C&displaylang=en
http://www.mysql.com/products/connector/j/
http://support.microsoft.com/kb/256986/EN-US/
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6. Repeat steps 3 through 5 for a key named TcpTimedWaitDelay and assign the value 30. 

7. Close the Registry Editor by selecting FileExit. 

8. Reboot the MySQL computer 

Without these settings, random errors of the nature, “[MySQL][ODBC 5.1 Driver]Can't 

connect to MySQL server on '<MyComputerName>' (10048)” display. The error is 

caused not by MySQL or the MySQL ODBC driver, but by the behavior of Windows. For 

performance reasons Windows maintains a connection on a TCP port after it is closed for (by 

default) 4 minutes. Under heavy load when lots of connections are opened and closed to the 

database, the system can hit a limit on the maximum number of connections allowed (even 

though as far as MySQL is concerned, these connections have been closed). 

Microsoft SQL Server Database and Microsoft Analysis Services 

If you are using Microsoft SQL Server 2008, you may experience unresolved table locking 

problems in your SQL Server database that prevents SAS Activity-Based Management batch 

processes from completing. The error states: 

Transaction (Process ID 58) was deadlocked on lock resources with 

another process and has been chosen as the deadlock victim. Rerun 

the transaction. 

This problem most commonly appears when SQL Server is heavily loaded and SAS Activity-

Based Management is generating cubes. 

To resolve this problem, you need to modify your database transaction isolation level.  

1. Launch the SQL Server Management Studio from the Start menu. 

2. Make sure you have selected Database Engine and the computer where your Database 

Engine is running. Log into SQL Server Management Studio using an appropriate 

administrative account. 

3. Open a query window by selecting the New Query toolbar button or by selecting New→ 

Query with Current Connection from the File menu. 

4. Paste the following query into the query window and change the text 

<MyAbmDatabaseName> to be the name of your SAS Activity-Based Management 

database: 

ALTER DATABASE <MyAbmDatabaseName> SET READ_COMMITTED_SNAPSHOT ON 

Choose Execute. 
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Chapter 6 – Installing SAS Prerequisites 

After completing Chapter 5- Installing Third-Party Prerequisites, you now have all the third-party 

software prerequisites installed and configured properly on the physical computer, or computers, 

in your deployment. Your next step is to install your SAS software. 

If you are new to installing SAS software, the process involves two components: 

 The software to be installed – a SAS Software Depot 

 A “Plan file” which describes which SAS software should be installed on which 

computer. This helps simplify complex installations. 

Your SAS software order was delivered with a sample Plan file that is suitable for the 

deployment information you provided when your software was ordered. If you want to change 

that deployment, please contact a SAS representative. 

As in the previous chapter, please verify that you are installing this software using the proper 

SAS Installer User that was identified in the previous chapter. 

SAS Software 

As part of your SAS software purchase, you will receive a Software Order E‐mail detailing the 

specific software included in your order, download instructions (or DVDs if requested) and a 

SAS Installation Data file (SID file) to activate your software. You will need this email to continue 

with the installation. The Software Order E‐mail is sent to the SAS Installation Representative at 

your site. If at any time you cannot find your Software Order E‐mail, you should go to the web 

site http://support.sas.com/adminservices-SID to have it re‐sent to the SAS Installation 

Representative at your site. For detailed instructions on the installation process, please refer to 

the SAS Deployment Wizard User’s Guide available on the web at the link below. 

During the installation, you will need to have access to the SAS Software Depot and Plan file. 

Keep these in a location that is accessible to all the machines. 

Download your software into the SAS Software Depot using either the SAS Download Manager 

or install the software from DVDs. For detailed instructions on the SAS Download Manager refer 

to 

http://support.sas.com/demosdownloads/sysdep_t1.jsp;jsessionid=BCF06A10DDE4E0303659C641

D400C784.tc5j5_external_w1?packageID=000738.  

For detailed instructions on the SAS Software Depot, please refer to the quick start documents at 

http://support.sas.com/documentation/installcenter/en/ikqsgbasicesd/64416/PDF/default/quicksta

rt.pdf for “basic” deployments and 

http://support.sas.com/documentation/installcenter/en/ikqsgplanesd/64415/PDF/default/quicksta

rt.pdf for deployments using a SAS “Plan” file.   

For detail instructions of installing the software from Basic DVDs, please refer to the quick start 

document at 

http://support.sas.com/documentation/installcenter/en/ikqsgbasicmedia/64440/PDF/default/quick

start_media.pdf.  

Then install the product from your SAS Software Depot using the SAS Deployment Wizard. For 

detailed instructions on the SAS Deployment Wizard, please refer to the SAS Deployment Wizard 

and SAS Deployment Manager 9.3: User’s Guide available at 

http://support.sas.com/demosdownloads/sysdep_t1.jsp;jsessionid=BCF06A10DDE4E0303659C641D400C784.tc5j5_external_w1?packageID=000738
http://support.sas.com/demosdownloads/sysdep_t1.jsp;jsessionid=BCF06A10DDE4E0303659C641D400C784.tc5j5_external_w1?packageID=000738
http://support.sas.com/documentation/installcenter/en/ikqsgbasicesd/64416/PDF/default/quickstart.pdf
http://support.sas.com/documentation/installcenter/en/ikqsgbasicesd/64416/PDF/default/quickstart.pdf
http://support.sas.com/documentation/installcenter/en/ikqsgplanesd/64415/PDF/default/quickstart.pdf
http://support.sas.com/documentation/installcenter/en/ikqsgplanesd/64415/PDF/default/quickstart.pdf
http://support.sas.com/documentation/installcenter/en/ikqsgbasicmedia/64440/PDF/default/quickstart_media.pdf
http://support.sas.com/documentation/installcenter/en/ikqsgbasicmedia/64440/PDF/default/quickstart_media.pdf
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http://support.sas.com/documentation/installcenter/en/ikdeploywizug/64204/PDF/default/user.p

df 

Before you continue, please visit our Technical Support website, http://support.sas.com, for any 

additional information.  

SAS Software Installation 

Please follow the instructions carefully and type your responses accurately. Correctly specifying 

port numbers, user names, and machine names are critical to ensuring your installation operates 

properly. A few extra minutes verifying your input can save many hours of debugging a simple 

typographical error. 

Using the SAS Deployment Wizard, install the required SAS software that you identified in 

Chapters 3 and 4 on the appropriate OLAP and, if you are not using an existing one, Metadata 

Server as well. These two servers may not need to have software installed on them. For example, 

if you are using Microsoft SQL Server Analysis Services then the OLAP Server installation is 

already complete. The same can be said if your site already has a SAS 9.3 Metadata server 

installed and configured. It is possible that the only SAS software remaining to install is the 

Calculation Server and the Mid-Tier Server, both of which will be covered in the next chapter. 

Depending on your deployment, it is also possible that only the Database Server installation is 

complete and all the others are remaining. 

Your Plan file will help you efficiently install the SAS software. If your Calculation Server will be 

installed on the same computer as the Mid-Tier Server, a proper Plan file will allow those two to 

be installed and configured at the same time. Your plan file can also allow you to install the 

OLAP Server and Metadata Server at the same time as well. 

Warning:  If you have a SAS Plan file that specifies that SAS software should be deployed onto two 

separate computers, you may be tempted to make one “pass” through the SAS Deployment 

Wizard and install “Software 1” on computer A and then rerun the SAS Deployment 

Wizard and install “Software 2” on computer A as well. If you install your software this 

way make sure you specify different configuration directories for each run of the Deployment 

Wizard. If you try to co-locate multiple sets of configuration files in a single directory, the 

configuration data from a subsequent installation may overwrite, and destroy or alter, the 

configuration data from a previous one. This will result in a non-functioning system.  

During the installation process update the configuration tables in Chapter 4 with port 

information, user names, etc. 

Important Deployment Questions 

There are several choices that the SAS Deployment Wizard will offer that impact your entire 

installation. This section will review those questions and provide guidance to make informed 

decisions. You may be queried about all of these choices when installing your software or you 

may encounter none. The queries you encounter depend on the software you are installing and 

which components are on which computer. 

Run as Windows Services (Windows Only) 

If you are installing on a Windows operating system, you have the choice to run certain service 

software as a Windows Service or by manually executing “management scripts”.  

There is no performance penalty associated with either choice. The decision really involves how 

you want to manage your computers. The advantage of Windows Services is that the Windows 

http://support.sas.com/documentation/installcenter/en/ikdeploywizug/64204/PDF/default/user.pdf
http://support.sas.com/documentation/installcenter/en/ikdeploywizug/64204/PDF/default/user.pdf
http://support.sas.com/
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operating system can automatically stop and restart them when Windows is shut down or 

restarted. The advantage of management scripts is that you choose when to start them and you 

have direct access to the start-up parameters (if any) provided by the scripts. However, if you 

choose to use management scripts, be aware that you must manually stop and start these service 

tasks yourself when Windows is shut down or restarted. If these tasks are not running the SAS 

applications will not run properly. SAS recommends that these tasks be run as Windows Services 

so they will automatically start when the computer is rebooted. Otherwise, they need to be 

manually started by an administrative user or via a script which runs after the computer has 

rebooted. 

Allow Anonymous Web Access 

Allowing Anonymous Web Access is often site-wide security policy at a company. Please check 

with your IT department about preferred web access policies. If you don’t have a specific need to 

allow anonymous access, SAS recommends that you leave this option disabled. 

Automatically Configure Your Web Application Server 

SAS Activity-Based Management and other SAS applications use a web application server to host 

portions of their application. If you choose, the SAS configuration process can automatically 

configure the applications servers or, you may optionally choose to perform those steps manually 

after the SAS configuration complete. The steps you need to manually perform are written to the 

instructions.html file that is generated for each computer in your deployment. For typical 

installations, SAS recommends that the web applications servers be automatically configured. 

Configure Multiple Managed Servers 

Depending on your deployment you may need multiple web applications servers on one 

computer. You have the choice to deploy and configure a web applications server for each 

application that needs one, or you may deploy a single web application server and have the 

applications share it. Many factors will influence your decision and this discussion is beyond the 

scope of this document. For more information see the SAS 9.3 Intelligence Platform: Web Application 

Administration Guide. For typical installations, SAS recommends that you configure multiple 

managed servers. 

SAS Software to Install 

The installation instructions for the SAS Metadata Server and the SAS OLAP Server are not 

covered as part of the SAS Activity-Based Management instructions. Instead, they are covered in 

the SAS 9.3 Intelligence Platform Installation and Configuration Guide. Please refer to that document 

for more information. 

There are many places where the Deployment Wizard will ask for a computer name. Unless 

specifically asked for an abbreviated name, please provide a fully-qualified name. Fully qualified 

names are usually of the form: <MyComputerName>.<MyCompanyName>.com or perhaps 

<MyComputerName>.<MyRegion>.<MyCompanyName>.org. One example would be: 

sasserver.eur.webcomputers.com. Abbreviated, or short, names are usually a simple name such 

as <MyComputerName> or simply sasserver. These names should not be prefixed with forward 

or backward slashes. Please consult with your internal computer support staff if you are 

uncertain about the proper format for your installation. 
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Warning:  SAS Activity-Based Management 7.2 does not support Pooled Workspace Servers. When 

configuring a SAS OLAP Server or the calculation server for SAS Activity-Based 

Management, please choose a regular, non-pooled, workspace server. 

Metadata Server 

The computer you have designated as the Metadata Server is the first computer you should install, 

configure and have running. It is used to store and share information about all the other 

computers on which you install SAS software. 

If you already have a functioning SAS 9.3 Metadata Server that you want SAS Activity-Based 

Management to share, you should not install another. Typical SAS installations share one 

Metadata Server unless you are creating multiple, independent environments. This is often the 

case, for example, when isolated Test and Production environments are used to partition ongoing 

work from work ready for widespread use and distribution. 

Please record the Metadata Server information you choose while installing the SAS Metadata 

Server. You will enter this information in the Host Name: and Port: options on the SAS Metadata 

Server wizard page while installing SAS Activity-Based Management. The SAS Metadata Server 

wizard page looks like this: 

 

OLAP Server 

Important:  If you are using SAS OLAP Server and you already have one installed, you may choose to 

share it with SAS Activity-Based Management or you may choose to install another 

instance on a separate computer for exclusive use by SAS Activity-Based Management. 

Unless prohibited by your product license, you may choose the deployment that best suits 

your needs. 

If you already have a functioning SAS 9.3 OLAP Server that you want SAS Activity-Based 

Management to use or if you are using Microsoft SQL Server Analysis Services for cube 

processing, you may skip installing another. For more information on the SAS OLAP Server, 

please refer to its documentation at 

http://support.sas.com/documentation/onlinedoc/olap/index.html 

http://support.sas.com/documentation/onlinedoc/olap/index.html
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Record the Logical Workspace Server Name you choose while installing the SAS OLAP Server. 

You will provide this name in the SAS Workspace Server for Creating Cubes option on the SAS 

Activity-Based Management Mid-Tier Dependencies wizard dialog: 

 

 

The SAS Activity-Based Management configuration creates the ABM Library in the SAS 

Metadata Server. This library uses the DSN definition on the OLAP Server to connect to the SAS 

Activity-Based Management database. If the OLAP Server and Calculate Server are hosted on the 

same computer, they will share the DSN. If they are hosted on separate computers, each 

computer needs an identical DSN definition. For more information on DSNs, see “Creating Data 

Sources” in Chapter 8. 
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Chapter 7 – Installing SAS Activity-Based Management 

This chapter will guide you through the installation of SAS Activity-Based Management 7.2 

server on the computer you identified as the Applications Server in your deployment. Please refer 

to Chapter 1 for a review. The SAS Activity-Based Management installation assumes that you 

either: 

 Have all the other servers in your SAS Activity-Based Management deployment installed 

and properly running or 

 The other servers in your SAS Activity-Based Management deployment that are not yet 

installed will be installed on the same computer as your SAS Activity-Based 

Management Mid-Tier Server. In other words, you are going to install them now. 

Important:  Certain hot fixes may cause problems with the operation of SAS Activity-Based 

Management. Please contact SAS Technical Support before applying any SAS hot fixes or 

service packs not explicitly mentioned in this document. 

The following sections guide you through the important SAS Deployment Wizard dialogs for 

installing SAS Activity-Based Management. Some wizard dialogs may ask for the same 

information at different points in the installation. This is unavoidable since each of the dialogs is 

intended for a server, mid-tier, or client computer. If your Plan file installs several components on 

a single computer, then all the configuration steps for each component are displayed – even if 

some of the information is redundant. 

Installing on UNIX 

The SAS Deployment Wizard that is used to install SAS Activity-Based Management is an X 

window application. If you are installing from a personal computer, you need to set up the 

display to your personal computer. For example: 

DISPLAY=<yourcomputer_absolute_address>:0.0 

export DISPLAY 

Interactive Prompting Levels 

Shortly after you begin running the SAS Deployment Wizard to interactively install and initially 

configure SAS, you will be asked to choose between three wizard prompting levels: 

 Express - displays the minimum number of dialog boxes to complete the configuration 

 Typical - displays the basic set of dialog boxes to complete the configuration 

 Custom - displays all the dialog boxes to complete the configuration 

The following table lists the configuration options and the prompt level in which they display for 

SAS Activity-Based Management only. Depending on your configuration, you might see 

differences for the prompt level in which a particular option displays.  

Important:  Your deployment will encounter more configuration options than these. The configuration 

options you encounter depend on which SAS products are identified in your deployment 

plan, and when performing multiple computer deployments, on which computer you are 

installing software. 
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Option in the SAS Deployment Wizard Express Typical Custom 

OLAP Server Options X X X 

Contributions Server Options   X 

Workspace Server for Cube and Calculations X X X 

Operations Port X X X 

Database Options X X X 

Database Connectivity and Upgrade Options X X X 

JUnit and SAS Environments Options X X X 

ODBC and Database Server Options X X X 

The only SAS Activity-Based Management choice that is not available for the Express prompting 

mode is the option to deploy the Contributions Server. The Contributions option is set to disabled 

during Express and Typical installation. 

Installing the SAS Activity-Based Management Calculation Server 

Launch the SAS Deployment Wizard and choose your Plan file. Then choose the computer from 

your Plan file that will host the Calculation Server. Verify the presence of “SAS Activity-Based 

Costing Configuration” in the Software to Configure subsection of the Details of the selected 

deployment plan: list box in the Deployment Wizard. This ensures that the SAS Activity-Based 

Management calculation process will be configured properly on this computer for use by the SAS 

Activity-Based Management server. 

 

Before you configure the SAS Activity-Based Management Calculation Server, you will configure 

the Logical Workspace Server that will execute the SAS Activity-Based Management calculation 

process. The Logical SAS Workspace Server Name you provide is the one you should choose 

when later prompted when you configure the Mid-Tier Server.  
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When you reach the Calculation Server configuration step, the SAS Activity-Based Management 

ODBC and Database Server Options wizard dialog opens: 

 

ODBC DSN Name: Specifies the Data Source Name (DSN) that the Calculation Server uses to 

connect to the SAS Activity-Based Management relational database you choose. By default, the 

Deployment Wizard suggests a default name that includes your configuration level name. You 

may change the name to any legally acceptable name you want. Legal characters for this name 

are operating system dependent. 

Important:  The Calculation Server needs the appropriate ODBC driver installed on it to communicate 

to the relational database you chose. This driver is operating system dependent. Depending 

on your deployment, you may have, for example, a Calculation Server on Windows and a 

Database Server on UNIX. Thus, a specific Windows driver to communicate with the 

UNIX-based database is needed. These drivers are not supplied by SAS. 

For more information on DSNs, see “Creating Data Sources” in Chapter 8. 
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Database Type: Specifies the relational database you want to use. Choices are: Microsoft SQL 

Server, Oracle, and MySQL. The available choices are not filtered according to operating system. 

For example, if you are installing on UNIX, then Microsoft SQL Server is still available in the list 

even though it is not a legitimate choice. Please refer to SAS Activity-Based Management 7.2 System 

Requirements for supported deployment options and specific version requirements. 

Host: Specifies the fully-qualified name of the computer where your database is hosted. 

Port: Specifies the port number your database is configured to communicate on. See “Designating 

Ports” in Chapter 4 for more information. 

Database or Schema Name: This is the database name inside your relational database. For SQL 

Server it is the database name; for Oracle it is the global database name; for MySQL it is the 

schema name. SAS recommends the name sasabmmodels. You should enter the name you 

recorded when you set up your database. 

These are the only Deployment Wizard configuration options that are specific to the SAS 

Activity-Based Management Calculation Server. 

Installing the SAS Activity-Based Management Mid-Tier 

If necessary, launch the SAS Deployment Wizard and choose your Plan file. Then choose the 

computer from your plan file that will host the Mid-Tier Server. Verify the presence of “SAS 

Activity-Based Management Mid-Tier” in the Software to Configure subsection of the Details of the 

selected deployment plan: list box. 
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Many deployment wizard dialogs will open as you proceed through the installation process. 

When you reach the portion of the wizard where you configure the web application server, there 

will be as few as zero to as many as seven web application servers to configure before you reach 

the Web Application Server: Eighth Managed Server dialog page. The actual number you 

encounter depends on how many products you are installing with your Plan file.  

If you did not select Multiple Managed Servers on the Web Application Server: Multiple 

Managed Server dialog, then all the applications that need a web application server on this 

computer will share a single instance. In this case, this wizard dialog will be named Web 

Application Server: Managed Server. 

The Eighth Managed Server dialog page is the web application server for SAS Activity-Based 

Management. 

 

Server Name: Specifies the server name that will appear when this instance of the web 

application server runs. If you are installing on Windows and selected Run as Windows Services 

on the Windows Options dialog, the service name appears in the Windows Services dialog as: 

 “JBoss - <MyName>” for JBoss web application server 

 “Oracle WebLogic NodeManager  - <MyName>” for WebLogic web application server 

 “IBM WebSphere Application Server V7 - <MyName>” for WebSphere web application 

server. IBM WebSphere may also create additional services depending on which options 

you chose during its installation. 

The default value for <MyName> is SASServer9 if you are configuring Multiple Managed 

Servers. If you are not configuring Multiple Managed Servers, the name defaults to 

SASServer1. 

HTTP Port: Specifies the port for the web application server to use for HTTP communication. 

HTTPS Port: Specifies the port for the web application server to use for HTTPS communication. 

If you do not configure the web application server to use HTTPS secure communication, this port 

is unused by SAS Activity-Based Management. If you are interested in using an HTTPS 

connection, please refer to your web application server documentation for configuring HTTPS 

with a certified certificate for your site. 

RMI Port: Specifies the port to use for Java-based RMI communication. This option is unused by 

SAS Activity-Based Management. 
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Configured Protocol: Specifies which protocol to use when client applications attach. Choices are 

HTTP Protocol or HTTPS Protocol. If you chose Express or Typical prompting modes this 

option is not displayed and is set to HTTP Protocol. 

 

Additional JVM Options: Specifies any additional parameters you want to pass to the Java 

Virtual Machine the runs inside this web application server. See your web application server 

documentation for more information. No additional parameters are passed by default. If you 

chose Express or Typical prompting modes this option is not displayed and provides no 

additional JVM parameters. 

Important:  If you did not select Multiple Managed Servers on the Web Application Server: 

Multiple Managed Server dialog, then all applications that share this web application 

server instance also share these settings. So, although SAS Activity-Based Management may 

not use, for example, the RMI Port option other applications may. 

 

When you reach the Mid-Tier Server configuration step, the SAS Activity-Based Management 

OLAP Server Options wizard dialog opens: 

 

Server Type: Specifies the OLAP server you want to use. This choice is operating system 

dependent. Your choices are: SAS OLAP Server and Microsoft SQL Server Analysis Services. 

Please refer to SAS Activity-Based Management 7.2 System Requirements for specific limitations and 

version requirements. You can choose SAS OLAP Server for use with any database supported by 

SAS Activity-Based Management. Microsoft SQL Server Analysis Services is only supported for 

Microsoft SQL Server and Oracle databases. MySQL is not supported and will not operate 

properly. 

Enable Contributions: Specifies whether to configure the SAS Activity-Based Management 

Contributions functionality. By default, this option is “off.” If you chose Express or Typical 

prompting modes this option is not displayed and is “off.” 
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The next wizard dialog conditionally displays. It is the SAS Activity-Based Management: 

Microsoft SQL Server Analysis Services dialog: 

 

This page only displays if you chose Microsoft SQL Server Analysis Services on the SAS 

Activity-Based Management OLAP Server Options dialog  

Host: Specifies the fully qualified name of the computer hosting SQL Server Analysis Services. If 

you defined a Default Instance, the \<InstanceName> qualifier should be omitted. Otherwise, 

specify the instance name. 

User ID: Specifies a domain account ID that has sufficient privileges to create, delete, and change 

permissions on cubes. If your deployment has the Microsoft SQL Server Analysis Services 

installed on the same computer as the SAS Activity-Based Management Mid-Tier Server, then this 

can be a local user. If you specify a local user, then <MyDomain> is replaced by the short 

computer name. The cube creation process on Microsoft SQL Server Analysis Services will run as 

this user. 

Password: Specifies the Analysis Services user’s password. 

Confirm Password: Verifies the Analysis Services user’s password. 

Authentication Domain: Specifies which authentication account to use for SAS Activity-Based 

Management users when creating and updating permissions on SAS Activity-Based Management 

created cubes. 
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The next wizard dialog conditionally displays. It is the SAS Activity-Based Management Mid-

Tier Dependencies dialog: 

 

This page only displays if you have already installed, configured, and have running an 

operational SAS Metadata server. It queries the Metadata server to discover other Logical 

Workspace Servers that have been deployed. For example, this allows SAS Activity-Based 

Management to lauch a calculation process on another computer. If you do not have an 

operational SAS Metadata server, then the choices offered by this wizard page are not needed 

because there are no other Logical Workspace Servers. Hence, this (these) process(es) run on the 

current computer. 

SAS Workspace Server for Calculations: Specifies which Logical Workspace Server to use for 

executing the SAS Activity-Based Management calculations.  

SAS Workspace Server for Creating Cubes: This option conditionally displays if you chose SAS 

OLAP Server on the SAS Activity-Based Management OLAP Server Options page. It specifies 

which Logical Workspace Server to use to running the SAS Activity-Based Management SAS 

OLAP cube building processes. 
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The next configuration step is the SAS Activity-Based Management: Ports wizard page: 

 

“Operations” Port: Specifies the port used by the SAS Activity-Based Management mid-tier to 

communicate with all SAS Activity-Based Management “operations”. These are long running 

processes such as importing model data, creating a report, or performing a model calculation. 

Windows Service Port: This option conditionally displays if you chose Microsoft SQL Server 

Analysis Services on the SAS Activity-Based Management OLAP Server Options dialog. This 

option is used by the SAS Activity-Based Management mid-tier to communicate with the OLAP 

cube creation processes. It is not used to communicate with Microsoft SQL Server Analysis 

Services directly. 

 

The next configuration step is the SAS Activity-Based Management: Database Information 

wizard dialog (part 1): 

 

Runtime User ID: Specifies the database login account for the SAS Activity-Based Management 

software to use when accessing the database. This is the database login name from your existing 
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SAS Activity-Based Management database or the database login from your new database 

installation. 

Runtime Password: Specifies the database user’s password. 

Confirm Password: A password entry text box to verify the password in the Runtime Password 

option. 

Important:  The databases were installed and configured in Chapter 5. The database and user 

information you provide is necessary for configuration to complete successfully. This 

information is used to attach to the database and create initial tables or to update the existing 

tables to the latest schema. If this information is incorrect, this process will not successfully 

complete. 

 

The next configuration step is the SAS Activity-Based Management: Database Information 

wizard dialog (part 2): 

 

JDBC Jar File: Specifies the location of the JDBC driver’s jar file for the database you have 

selected. This JDBC driver is used by the SAS Activity-Based Management mid-tier to 

communicate with the database. For Microsoft SQL Server and Oracle databases, this is the jar 

file you installed in Appendix A and Appendix B, respectively. For a MySQL database, this is the 

jar file for the MySQL Connector/J you installed in Appendix C. 

Net Service Name: This option conditionally displays if you are using an Oracle database and 

you have chosen to use Microsoft SQL Server Analysis Services for OLAP. Specifies the Net 

Service Name you have designated in your Oracle database for SAS Activity-Based Management. 

You created this Net Service in Appendix B. 

Global Database Name: This option conditionally displays if you are using an Oracle database. 

Specifies the Global Database Name you have designated in your Oracle database for SAS 

Activity-Based Management. You created this Net Service in Appendix B. 

The Global Database Name can be tricky to specify correctly because conventions have changed 

slightly in recent versions of the Oracle database. The Oracle Global Database Name typically 

contains the Service Name (alias) or SID (unique name of the database instance) followed by the 

domain suffix.  
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For example, if the Service Name is "orcl" and the domain suffix is "na.test.com", then the correct 

Global Database Name would be: orcl.na.test.com  

However, it is possible to configure the Oracle Global Database Name to be the same as the 

Service Name or the SID. This is especially true for many default setups for database instances 

prior to Oracle 11g R2.  

If you specify an incorrect Global Database Name you might observe an error similar to the 

following in the SAS Activity-Based Management installation log during your SAS Activity-

Based Management installation:  

[echo] java.sql.SQLException: Listener refused the connection with the 

following error: 

[echo] ORA-12514, TNS:listener does not currently know of service 

requested in connect descriptor 

If the database contains previous…: Specifies the action to perform if the database you have 

provided already contains SAS Activity-Based Management models. The two choices are: 

 Upgrade existing database 

 Reinstall database 

The selection “Upgrade existing database” will examine the version number of SAS Activity-

Based Management schema in your database and will perform the necessary steps to update it to 

SAS Activity-Based Management 7.2 format. This option is valid for any SAS Activity-Based 

Management version 6.x. If the existing schema is up to date, no action will be taken. 

The selection “Reinstall database” will erase the contents of the existing database and re-creates a 

new, empty database. This selection will destroy all existing data. This selection resets the 

database to a new state as though there was no previous SAS Activity-Based Management data 

present. No further warnings will be given when the database contents are erased. 

Warning:  This selection will destroy existing data in your database. Once this choice is made and the 

wizard proceeds to the next steps, no additional warnings or confirmations will appear. 

See Chapter 8 – SAS Activity-Based Management Migration Utility for more information. 

Do you want to localize…: Specifies whether to localize the names of objects in the SAS Activity-

Based Management database. If you select “True” the objects names in the database will be 

localized using the locale setting of your SAS Metadata server. If you select “False” the database 

object names will remain in English. 
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Warning:  If you are upgrading from a previous version of SAS Activity-Based Management and you 

selected the option “Upgrade existing database”, then you should make the same choice here 

that you made when installing the previous version of SAS Activity-Based Management. If 

you don’t make the same choice, then Saved OLAP Views may not operate properly in SAS 

Activity-Based Management 7.2. This happens because the saved OLAP Views included 

localized names in portions of their content. 

 

The next configuration step is the SAS Activity-Based Management: Required Software wizard 

dialog: 

 

JUnit Jar File: Specifies the jar file used by the SAS Activity-Based Management Diagnostics 

application. 

Enter the URL for the file…: Specifies the SAS environments file to use for the SAS Activity-

Based Management Diagnostics application. The Diagnostics application uses the environments 

file to locate other computers in your SAS installation. The sas-environment.xml file is located on 

the computer where the SAS Web Infrastructure Platform (WIP) was installed. This is typically 

your SAS Metadata Server. The port number specifies the port the web application server is 

configured to use. See “Designating Ports” in Chapter 4 for more the default port values for the 

supported web application servers. 

Deployment Errors 

If any errors are found during configuration you have the opportunity to fix them and Retry the 

operation before continuing.  

You can see the context of the error by examining the Deployment in Progress status dialog. 

Each successfully installed/configured item will have a green check mark next to it. If any error 

dialogs are displayed during the installation or configuration process, click the link in the dialog 

to view the log file. Examine the log file for errors by searching for the word “error”. The most 

recent errors or warnings appear at the end of the log file. Examine each error for meaningful 

content. The most common error during SAS Activity-Based Management configuration is a 

failure to attach to your database or the sasabmmodels database/schema within. If this problem 
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occurs, log into your database management console and verify the database user, the 

sasabmmodels database/schema and its permissions. Then click Retry on the error dialog. 

You must resolve any errors before continuing. Failure to do so will result in either an incomplete 

installation or an incomplete configuration. 

Installing the SAS Activity-Based Management Client 

Note:  As with all SAS client products, the SAS Activity-Based Management client will 

automatically be installed with SAS/SECURE. However, since the SAS Activity-Based 

Management client uses HTTP or HTTPS communication with the server, it does not need 

SAS/SECURE, so you may choose to not install it. However, if you are using other SAS 

client products, such as the SAS Management Console, you should install it. 

If necessary, launch the SAS Deployment Wizard, and choose your Plan file. Then choose the 

computer from your plan file that will host your client applications. Verify the presence of “SAS 

Activity-Based Management Client” in the Software to Install subsection of the Details of the selected 

deployment plan: list box. 
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Depending on the other software you are installing on your client computers, many wizard 

dialogs will open. For the SAS Activity-Based Management client, the only configuration step 

that is important is the Specify URL for Available Servers File wizard dialog: 

 

Available Servers File: Specifies the SAS environments file used by the SAS Activity-Based 

Management client application (and any other SAS clients that you install on this computer). The 

client application uses the environments file to locate other computers in your SAS installation. 

For most installations, <MyComputerName> is the computer that hosts your metadata server and 

the default port is dependent on the web application server you are using: 

 JBoss   : 8080 

 Oracle WebLogic : 7001 

 IBM WebSphere : 9080 
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Chapter 8 – Post-Installation 

After installation and configuration, these post-installation steps verify the folder permissions, 

add SAS Activity-Based Management users, and test the installation. Make sure you have 

restarted all the server computers before you begin.  

Validating the Installation 

After completing your installation, you should review and follow the steps in the instructions.html 

file that was automatically generated as part of your installation. A link to this file in provided on 

the last page of the SAS Deployment Wizard. 

Several of the steps in the instructions.html file refer to the detailed instructions provided in this 

chapter. You may skip ahead to the necessary sections in this chapter to complete those steps, if 

necessary. 

Windows Chinese Traditional Localization (Client Only) 

Due to a bug in Microsoft Windows, the "Chinese (Traditional, Taiwan)” locale is not properly 

recognized by the SAS Activity-Based Management client on a Chinese Taiwanese (ZH_TW) 

Windows operating system. This Windows bug causes the Microsoft .NET locale detection 

mechanism to incorrectly identify this locale as "Chinese (Traditional, Hong Kong S.A.R)” 

(ZH_HK). This means that the Chinese Taiwanese resources will not be correctly found by the 

SAS Activity-Based Management client program since Windows tells it to look in the wrong 

directory. 

To resolve this problem, after the SAS Activity-Based Management client is installed, find the 

directory where the client is installed, typically “C:\Program Files\SAS\Activity-Based 

Management Solution\Activity-Based Management Solution\Client”. Locate the 

ZH_TW directory under the client installation folder where the resources are installed and copy 

that directory, and any subdirectories, to a new directory named ZH_HK. Then restart the client 

program. Your Chinese Traditional localizations should appear as expected. 

Important:  Unlike the other post-installation changes outlined in this chapter, this modification is done 

on the Client computer(s) not the Server computers. 

Allocating Memory for the Java Virtual Machine 

When SAS Activity-Based Management is configured, a default amount of memory is reserved 

for the Java Virtual Machine (JVM) for use by SAS Activity-Based Management “operations”. If 

this setting is too large, the JVM might consume more RAM than necessary (hence reduce the 

amount of memory available for other tasks on that computer) and if it is too small some SAS 

Activity-Based Management tasks may fail due to lack of memory.  

In particular, importing large models via XML or staging tables may fail due to insufficient heap 

space. These problems can be resolved by increasing the heap size used by SAS Activity-Based 

Management “operations” on the Mid-Tier Server. The option is in the 

“OperationConfig.properties” file located in the 

<CONFIGHOME>\Applications\SASActivityBasedManagement7.2\config directory. 

You need to specify a larger Xmx value in the line "OutOfProcessJavaOptions=-server|-
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Xms256m|-Xmx1024m|". SAS suggests trying a value of 2048 for Xmx if you are on a 64 bit 

operating system and a value of 1500 if you are on a 32 bit operating system. Larger values may 

be needed for very large models. 

Many SAS Activity-Based Management installations will not need to change Xmx. Users of small- 

and medium-sized models (fewer than 25,000 accounts and 100,000 assignments) should find the 

default value sufficient. 

Managing External Users 

Depending on your deployment choices you may have two, and perhaps three, places to manage 

SAS Activity-Based Management users and their permissions: 

 the internal users in the SAS Activity-Based Management User’s group in the SAS 

Metadata Server 

 the “published reports” directory 

 the “SAS OLAP server” cube directory (if using SAS OLAP Server) 

You can manage access in two ways. You can simply add and remove individual users to these 

locations or you can create operating system groups. Provide those groups required privileges to 

the correct locations and add users to those groups. If you create domain, or network groups, you 

can manage users from a single location. If you have many SAS Activity-Based Management 

users, managing them individually may become problematic and error prone. For example, if a 

new user is not granted appropriate privileges on the “published reports” directory, then he/she 

will receive an error when trying to view a report. These types of access control problems can be 

difficult to diagnose in complex deployments. 

This document provides instructions for managing users individually. If you want to manage 

users via groups, the process is similar except you first create a group for each unique access 

criterion. Then perform the same steps with the group. 

Creating Data Source Names (DSNs) 

SAS Activity-Based Management uses a DSN on the Calculation Server so the calculation engine 

can locate your SAS Activity-Based Management database. 

Important:  Windows distinguishes between 32 bit ODBC drivers and 64 bit ODBC drivers. Windows 

also distinguishes between 32 bit DSNs and 64 bit DSNs which use ODBC drivers. 32 bit 

DSNs can only use 32 bit ODBC drivers and 64 bit DSNs can only use 64 bit ODBC 

drivers. 

32 Bit Windows 

Microsoft SQL Server 

1. Open Administrative Tools→Data Sources in the Control Panel. 

2. Select the System DSN tab. If a DSN exists with the data source name you entered in the 

SAS Deployment Wizard, delete it by selecting the DSN name in the list and choosing 

Remove. Now create a new DSN by selecting the Add… button. 

3. Select the driver name that is appropriate for your database from the list box. For 

Microsoft SQL Server 2008 choose SQL Server Native Client 10.0. Select Finish to create 

the connection. 
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4. Enter the data source name you entered in the SAS Deployment Wizard in the Name 

field. Enter a description of this data source into the Description field. SAS suggests 

“Connection to the SAS ABM database”. Select the computer, instance name, and port 

hosting your database from the Which SQL Server do you want… list. The name is 

typically entered as <ComputerName>,<Port>. If you are attaching to a Named 

Instance of SQL Server, you do not need to specify the instance name. Since each instance 

of SQL Server on a computer must be mapped to a unique port, the computer name and 

port number are sufficient to fully specify which instance of SQL Server to connect to. 

Select Next. 

5. Choose SQL Server Authentication and enter the database username and password you 

provided to the SAS Deployment Wizard for accessing the SAS Activity-Based 

Management database. Select Next. 

6. Accept the default values for the next wizard dialog and select Next. 

7. Accept the default values for the last wizard dialog and select Finish. 

8. Select Test Data Source to verify connectivity. Click OK when the connection is verified. 

Click OK to complete creation of the DSN. 

MySQL 

1. Open the Control Panel. Open Administrative Tools→Data Sources. 

2. Select the System DSN tab. If a DSN exists with the data source name you entered in the 

SAS Deployment Wizard, edit it by selecting the DSN name in the list and choosing 

Configure. If an appropriately named DSN does not already exist, create a new one by 

selecting the Add… button. 

3. Select the driver name that is appropriate for your database from the list box. For MySQL 

choose MySQL ODBC 5.1 Driver. Select Finish to create the connection. 

4. The MySQL Connector/ODBC dialog displays. 

 

5. Enter the DSN name you provided the SDW for SAS Activity-Based Management. Enter 

a description of this data source into the Description field. SAS suggests “Connection to 

the SAS ABM database”. Enter the Server name and Port for your database. Enter the 

User, Password, and SAS Activity-Based Management models Database information as 

well. Refer to the table you created in Chapter 4 for port information. 
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6. Select the Details >> button to see additional configuration options. The Details portion 

of the dialog displays. 

 

7. Select the Connection tab. For most installations, select utf8 for the Character Set. For 

Asian installations, the character set must match the locale setting of the SAS Workspace 

Server on the Calculation Server. In the rare circumstance that you have mixed-languages 

in your data (for example Simplified and Traditional Chinese characters) then you must 

set both the SAS Workspace Server locale and the DSN character set to utf8. 

8. Select Test to verify the information you entered enables a successful connection to the 

SAS Activity-Based Management database. Click OK to complete creation of the DSN. 

Oracle 

1. Open the Control Panel. Open Administrative Tools→Data Sources. 

2. Select the System DSN tab. If a DSN exists with the data source name you entered in the 

SAS Deployment Wizard, edit it by selecting the DSN name in the list and choosing 

Configure. If an appropriately named DSN does not already exist, create a new one by 

selecting the Add… button. 

3. Select the driver name that is appropriate for your database from the list box. For Oracle 

choose Oracle in <MyOracleHomeName> where <MyOracleHomeName> is the home 

name you provided when you installed the Oracle database. Select Finish to create the 

connection. 

 

4. The Oracle ODBC Driver Connection dialog displays. Enter the Data Source Name you 

supplied to the SAS Deployment Wizard. Enter a description of this data source into the 

Description field. SAS suggests “Connection to the SAS ABM database”. Enter the Net 
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Service Name you created as detailed in the section “Oracle Net Configuration” in 

Appendix B. Enter the SAS Activity-Based Management user/schema you created as part 

of your Oracle database installation into the User ID field. Refer to the table you created 

in Chapter 4 for more information. Click Test Connection to verify the configuration. 

Click OK when complete. 

Important:  The Data Source Name you use must match the Net Service Name. This is 

necessary because the SAS Activity-Based Management calculation engine uses 

both database connection mechanisms to load data into the Oracle database. It 

assumes the Net Service Name is the same as the DSN name. 

 

64 Bit Windows 

The steps to create a DSN on a 64 bit Windows computer are identical to those on a 32 bit 

Windows computer. Please follow the instructions in the previous section.  

You also need a 32 bit DSN that attaches to the same data source if you want to use Base SAS to 

persist the query results from the SAS Activity-Based Management Contributions viewer. The 32 

bit DSN functionality is hidden in 64 bit Windows by default. You can launch it by typing 

<WindowsDir>\SysWOW64\odbcad32.exe into the Start→Run… command box. Follow the 

same steps listed above to create the 32 bit DSN. 

UNIX 

See your operating system instruction manual for exact steps. For reference, SAS provides a 

document for general use of ODBC connections with SAS. It is available at 

http://support.sas.com/techsup/technote/ts685.pdf.  

For Solaris users, help is available on Oracle’s website at 

http://developers.sun.com/asp/howto/createdsn.html. 

Important:  If you use the DataDirect ODBC drivers, make sure you set EnableNcharSupport to 1 when 

creating the DSN for Oracle on UNIX. SAS has not validated the DataDirect ODBC 

drivers on Windows for Oracle, so it is unknown if this option applies there as well. 

Persisting Results from the Contributions Viewer 

SAS Activity-Based Management has an optionally installable feature referred to as the 

Contributions Viewer. This option is installed if you selected the Enable Contributions checkbox 

http://support.sas.com/techsup/technote/ts685.pdf
http://developers.sun.com/asp/howto/createdsn.html
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during installation. If you did not select this option or if you do not plan on using Base SAS to 

persist Contributions results, you may skip to the next section. 

In order to persist Contributions results, the SAS Activity-Based Management calculation engine 

on the Calculation Server must be able to invoke, or call into, the Contributions program code. To 

enable this, you must perform these two steps: 

1. Copy the five Java files “sas.solutions.abm.contributions.jar”, and 

“sas.solutions.abm.contributions.nls.jar”, “commons-logging.jar”, “sas.antlr.jar”, and 

“log4j.jar”, which can be found on the Mid-Tier Server, into a suitable directory on the 

Calculation Server. 

2.  Add these five files onto the end of your existing, if any, Java CLASSPATH. 

Windows: 

a. Open the System dialog box via StartControl PanelSystem.  

b. Open the Advanced Tab and click Environment Variables. 

c. Under System Variables, highlight CLASSPATH and click Edit. If CLASSPATH 

does not exist, click New. Append each of the five .jar files listed above 

prepended with the directory name where you placed the .jar files separated 

with a semicolon. For example, if you placed the .jar files in the directory 

C:\SAS\ABM, then enter the path as 

C:\SAS\ABM\sas.solutions.abm.contributions.jar. If there is existing 

path information in the CLASSPATH, append a semicolon to the end before 

adding your five paths. For example: 

C:\SAS\ABM\sas.solutions.abm.contributions.jar;C:\SAS\ABM\

sas.solutions.abm.contributions.nls.jar;C:\SAS\ABM\commons

-logging.jar;C:\SAS\ABM\sas.antlr.jar;C:\SAS\ABMlog4j.jar 

d. Click OK for each of the windows opened. 

 UNIX: 

The following commands set the PATH environment variable on UNIX. These statements 

can be added to the .profile file of the user that is running the installation. Alternatively 

this can be added to a common profile accessed by the user’s profile. 

For example, if you placed the .jar files in the directory /SAS/ABM, then enter the path as 

/SAS/ABM/sas.solutions.abm.contributions.jar when executing the 

following commands: 

CLASSPATH=$CLASSPATH:/SAS/ABM/sas.solutions.abm.contributions.

jar:/SAS/ABM/sas.solutions.abm.contributions.nls.jar:/SAS/ABM/ 

commons-logging.jar:/SAS/ABM/sas.antlr.jar:/SAS/ABM/log4j.jar 

export CLASSPATH 

Finally, in order to persist the Contributions results via Base SAS, a 32 bit DSN named ABMDSN 

must be defined. This value cannot be changed. If you have already defined another DSN for used 

by the SAS Activity-Based Management Mid-Tier Server whose name differs, SAS recommends 

that you create a duplicate one with the ABMDSN name. 

The Oracle Bulk Data Loader 

This section applies to installations using the Oracle database. Other database users may skip this 

section. 
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The Calculation Server uses the Oracle bulk data loader to improve performance when loading 

and saving data from an Oracle database. Two changes are needed for the Calculation Server to 

properly access the Oracle bulk data loader: 

1. The Oracle bulk data loader, named sqlldr.exe on Windows systems and sqlldr on UNIX 

systems, must be in the PATH environment so the SAS Activity-Based Management 

calculation process can properly invoke it. 

2. Additionally, the SAS processes need authorization to launch the Oracle bulk data 

loader. To allow this, set the ALLOWXCMD option as follows on the SAS Workspace 

Server or SAS Batch Server on your Calculation Server computer as follows: 

a. In SAS Management Console, expand the Server Manager. 

b. Right-click the SAS Workspace Server for your Calculation Server computer and select 

Properties. 

c. In the Properties dialog box, click the Options tab. 

d. In the Options tab, click Advanced Options.  

e. In the Advanced Options tab, click the Launch Properties tab. 

f. In the Launch Properties tab, select the Allow XCMD check box. 

g. Click OK twice to save changes and close the Properties window. 

All new sessions on that particular SAS Workspace Server will run with the option 

ALLOWXCMD. Restart your current instance of SAS Data Integration Studio to run jobs with the 

ALLOWXCMD option on that server. 

Importing and Exporting Model Data 

SAS Activity-Based Management can import and export model data from or to any data source 

for which you have a JDBC driver, ODBC driver, or for which you have a SAS/ACCESS engine.  

If you want to use a JDBC driver and the database you want to “write data to” or “read data 

from” is not the same type as your SAS Activity-Based Management database, then you need to 

configure a JDBC driver for each unique database. 

For example, if you are using Microsoft SQL Server for your SAS Activity-Based Management 

database and you want access data that resides in an Oracle database, then you must configure 

an Oracle JDBC driver. If your SAS Activity-Based Management database and all the data you 

need to access are in Microsoft SQL Server, or accessible via SAS/ACCESS, then you may skip the 

remainder of this section. 

To configure SAS Activity-Based Management to access data in an additional database, perform 

the following steps on your Mid-Tier Server: 

1. Obtain a JDBC driver for your data source. The sections entitled “JDBC Driver” in 

Appendix A, Appendix B, and Appendix C explain how to obtain a suitable driver for 

SQL Server 2008, Oracle 11g, and MySQL 5, respectively. JDBC drivers for other 

databases can be obtained from the database vendor. 

2. Copy the .jar file, or files, for the JDBC driver into the JDK “extension” directory. If your 

Mid-Tier Server is on Windows, the extension directory is located in the \jre\lib\ext 

directory under the JDK installation directory. This is typically located at C:\Program 

Files\Java\jdk1.5.0_15\jre\lib\ext. Other operating systems are similar. 
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3. Add the JDBC jar name, or names, at the end of the SAS Activity-Based Management 

configuration file “sas.abm.outproc.java.ext.config”. This file is located at 

<CONFIGHOME>\Applications\SASActivityBasedManagement7.2\config. 

Save the updated .config file. 

4. Restart the web application server. See the “Instructions.html” file that was generated as 

part of your installation for detailed instructions on how to do this. It is located at: 

Windows: <CONFIGHOME>\Documents 

UNIX:   <CONFIGHOME>/Documents 

Warning: Do not needlessly copy a JDBC driver that duplicates the one you use for the SAS Activity-

Based Management database. Doing so will cause the web application server to load the .jar 

file twice which will result in class loading errors and a nonfunctioning installation. 

Microsoft Office 

SAS Activity-Based Management supports importing and exporting data from and to Microsoft 

Office applications. As noted above, to perform these tasks you need the proper data access 

drivers. For Microsoft Office, you need the Office ODBC drivers that are compatible with the 

version of Microsoft Office you are using. Please note that there are 32 bit and 64 bit versions of 

these drivers. You must install the 32 bit versions since the SAS Activity-Based Management 

client application is 32 bit and can only access 32 bit drivers. 

Note: In previous versions of SAS Activity-based Management, Microsoft Office files were 

imported from the Server, hence the Office ODBC drivers needed to be installed there. 

Microsoft no longer supports Office drivers on a server operating system or on a computer 

used as a server in a deployment architecture, regardless of its operating system. Hence, SAS 

changed the SAS Activity-based Management’s Office import architecture to work from the 

client computer, not the server computer. 

It does not matter if you use 32 bit drivers or 64 bit drivers to access your Office files. The y both 

have the same size limitations. If you have a 64 bit version of Office (either 2007 or 2010) on your 

client computer, you may not be able to install a 32 bit driver for Office 2007 or 2010 respectively. 

But you can install the 32 bit versions of the Office 2010 or 2007 drivers. For example, If you have 

a 64 bit version of Office 2010 and cannot install the 32 bit version of the Office 2010 drivers, you 

can install the 32 bit versions of the Office 2007 drivers and all will function correctly. 

Note: Make certain you install the 32 bit versions of the Office drivers. 

The drivers for Office 2007 products are available from Microsoft here: 

http://www.microsoft.com/downloads/details.aspx?familyid=7554f536-8c28-4598-9b72-

ef94e038c891&displaylang=en  

The drivers for Office 2010 products are available from Microsoft here: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=C06B8369-60DD-4B64-A44B-

84B371EDE16D&displaylang=en 

OLAP Permissions 

SAS OLAP Server 

SAS OLAP Server uses operating system authentication to manage access to cubes. In this 

respect, SAS manages cubes in the same manner it manages reports. Thus, SAS requires that each 

http://www.microsoft.com/downloads/details.aspx?familyid=7554f536-8c28-4598-9b72-ef94e038c891&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=7554f536-8c28-4598-9b72-ef94e038c891&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=C06B8369-60DD-4B64-A44B-84B371EDE16D&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=C06B8369-60DD-4B64-A44B-84B371EDE16D&displaylang=en


61 

user of SAS Activity-Based Management have proper access to the directory where SAS OLAP 

cubes are created. Any user who wants to create or delete OLAP cubes must have sufficient 

privileges on that folder and cube file to perform that operation. Any user who wants to view 

cubes must have read privileges on that cube. These access privileges are granted by the host 

operating system and are not managed by the SAS metadata server. 

Tip Using operating system groups can simplify user management. 

Windows 

1. Open Windows Explorer on the SAS Activity-Based Management OLAP Server and 

browse to the directory where SAS OLAP cubes are created at: <CONFIGHOME>\ 

AppData\SASActivityBasedManagement7.2\cubes. Create this directory if it does 

not already exist. 

2. Right-click on the cubes directory and select Properties… 

3. The cubes Properties dialog displays. Select the Security tab. 

4. Make sure each SAS Activity-Based Management user who creates cubes has Modify, 

Read, and Write access to the directory. When you select Modify, the Read & Execute 

and List Folder Contents privileges are also selected. Also make sure each SAS Activity-

Based Management user who views cubes has Read access to the directory. 

 

or 

 

5. Finally, each user who creates SAS OLAP cubes must have Log on as a batch job 

permission. However, this was already set up in Chapter 4 when you set up the SAS 

Server Users group.  

UNIX 

1. Navigate to the directory where SAS OLAP cubes are created on the SAS Activity-Based 

Management OLAP Server at: <CONFIGHOME>/ 

AppData/SASActivityBasedManagement7.2/cubes. Create this directory if it does 

not already exist. 

2. Make sure each SAS Activity-Based Management user who creates cubes has Read, 

Write, and Execute access to the directory. Also make sure each SAS Activity-Based 

Management user who views cubes has Read access to the directory 

3. Each user who creates SAS OLAP cubes must be part of the SAS Servers Users group. 

However, this was already set up in Chapter 4 when you set up the SAS Server Users 

group. 

4. Execute the following command to change permission on the directory: chmod 771 

<CONFIGHOME>/AppData/SASActivityBasedManagement7.2/cubes. 

5. Finally, the default security for files created is 755 or lower, so add umask 771 in the 

.sh file that launches the SAS Workspace Server on your OLAP Server so that files 

created in the cubes folder will have the proper permissions. 
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Windows Services 

This section explain how to launch your SAS Activity-Based Management service process if you 

did not select Run as Windows Services and are instead launching them manually or using 

management scripts to run them. This section only applies to Windows installations using 

Microsoft SQL Server Analysis Services for OLAP. 

If you are using Microsoft SQL Server Analysis Services, there is a ABMServer process that 

marshals communication between the Java-based process on the Mid-Tier Server and the .NET-

based processes on the OLAP Server (which in this specific case is a Windows computer using 

Microsoft SQL Server Analysis Services). Since you elected not to run this process as a service, 

you must run it under a user account. The user that runs the ABMServer process must have 

sufficient privileges to impersonate the cube creation user you provided in SAS Activity-Based 

Management: Microsoft SQL Server Analysis Services wizard dialog on your OLAP Server. This 

typically means that the user must be a member of the Power Users group on the Mid-Tier Server. 

You need to manually restart this process each time you reboot the Mid-Tier Server or whenever 

you log out of the Mid-Tier Server. To launch the ABMServer process manually: 

1. Open Windows Explorer on the SAS Activity-Based Management Mid-Tier Server and 

browse to the folder at: <SASHOME>\ 

SASActivityBasedManagementServer\7.2\bin directory. 

2. To launch it, right-click on ABMServer.exe and select Run as…. 

3. You can either run it as the Current user if the user has sufficient privileges or you may 

choose The following user and specify a user name and password. Click OK. 

4. Do not log off the computer. If you do, this process will stop running and your SAS 

Activity-Based Management server will not properly create cubes. 

Migrating From Version of SAS Activity-Based Management 

At this point in the installation process, you should currently have one of the supported database 

versions already installed. This database should also contain your SAS Activity-Based 

Management model data from a previous version of SAS Activity-Based Management. This 

process was detailed in Appendix D: Third-Party Migration. 

The two following sections detail the additional steps to be performed form migrating your 6.x or 

7.1 installation to SAS Activity-Based Management 7.2. 

Migrating from Version 7.1 

Migrating from version 7.1 to 7.2 is handled completely by the SAS Migration Utility. No 

additional steps need to be performed. You can skip the next few sections and resume with the 

section entitled Validating the SAS Activity-Based Management Solution. 

Migrating from Version 6.x 

This section explains how to migrate data from SAS Activity-Based Management version 6.x to 

the current database schema in SAS Activity-Based Management 7.2. If you are new to SAS 

Activity-Based Management, you can skip this section. 

Important:  Make sure you have backed up your data before proceeding! 
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The SAS Activity-Based Management migration is installed on the SAS Activity-Based 

Management Mid-Tier Server at 

<SASHOME>\SASActivityBasedManagementServer\7.2\bin\dbupgrade.exe, along 

with the necessary support files and database scripts. In addition to the database update program 

and its components, the computer that runs the upgrade program also needs: 

 the client connectivity tools for your database 

 an installed and running version of the 9.3 SAS Metadata Console 

It needs these two components to communicate with your database and to connect to the SAS 

Metadata Server to migrate your SAS Activity-Based Management 6.x users and roles to their 

new counterparts in the SAS Metadata Server. 

Important:  The dbupgrade.exe utility only runs on Windows computers with .NET 2.0 or .NET 3.5 

installed. Although it is installed as part of the Mid-Tier Server, it does not need to run from 

that server. It may run from any server that can access your SAS Activity-Based 

Management database. If you need to manually move the dbupgrade.exe to a Windows 

computer, please contact SAS for more information. 

There are four steps for migrating from SAS Activity-Based Management 6.x. They are: 

1) Run the dbupgrade.exe utility to update your 6.x database to version 7.1. 

2) Install SAS Activity-Based Management 7.2. The installation also updates your 7.1 

database to version 7.2. 

3) Re-run the dbupgrade.exe utility to migrate the users in your database to the SAS 

Metadata Server. This step is necessary because user information was not stored in the 

SAS Metadata Server in versions 6.x of SAS Activity-Based Management. 

4) Move any Published Reports you created in version 6.x to the proper directory location 

for 7.2 

Database 

This upgrade utility automatically updates any version 6.x database to the current version. If you 

have an SAS Activity-Based Management database that is older than 6.0, please contact SAS 

Technical Support for help migrating your data. 

SAS Activity-Based Management 6.x used two databases whose default names were OEAdmin 

and OEModels for SQL Server or a single OEModels database for Oracle. 

At this point in the installation and configuration process, you have a SQL Server 2008 or Oracle 

11g installation that contains your SAS Activity-Based Management data from a previous 

version. 

Run the dbupgrade.exe utility to update your 6.x database. Select the option entitled, 

“Upgrade database to SAS Activity-Based Management 7.1”. The database update performs these 

actions: 

1. Updates the existing 6.x tables to the 7.1 format. It does not change the name or password 

of your databases. 

2. Converts SQL Server installations to use a single database. OEAdmin is no longer 

needed. 
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Microsoft SQL Server and Oracle Databases 

Specify the target SAS Metadata Server. This is where the user data discussed above will be 

created. After entering the metadata server connection information, verify the information by 

selecting the Connect button. If an error occurs, verify your connection information and try 

again. 

Microsoft SQL Server 

 

(Database Server) Type: Specifies the database type. Choose SQLServer.  

(Database Server) Machine: Specifies the computer hosting the SQL Server database. 

(Database Server) User: Specifies either a SQL Server database user account or a system user’s 

account. If a system user’s account is provided, it will typically be a domain user. If the migration 

utility is run on the same computer as the database is installed, it may be a local account. The 

user must have the db_owner privilege for both the OEAdmin and OEModels databases. This 

user can be the SQL Server database user you created for the SAS Activity-Based Management 

application to access the database. 

(Database Server) Password: Specifies the database or system user’s password. 

(Database Server) Log in using my current credentials: If selected, this migration utility will use 

the account name a password of the current Windows user. When selected, the User and 

Password entry fields will be disabled. 

(Database Server) Admin Database: The name of your SAS Activity-Based Management admin 

database. This is typically OEAdmin. 

(Database Server) Model Database: The name of your SAS Activity-Based Management models 

database. This is typically OEModels. 
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Oracle 

 

(Database Server) Type: Specifies the database type. Choose Oracle.  

(Database Server) Alias: Specifies the alias to use to connect to the Oracle database. If you are 

running the SAS Activity-Based Management Database Upgrade Utility on your Database Server, 

then you already created this Net Service (Alias) in Appendix B. 

(Database Server) User: Specifies a user (or schema) to connect to the SAS Activity-Based 

Management database. This user can be the Oracle schema you created for the SAS Activity-

Based Management application to access the database. This user must have equivalent access 

privileges to properly perform its tasks. See “Create the SAS Activity-Based Management User” 

in Appendix B for more information. 

(Database Server) Password: Specifies the password for the provided Alias. 

Users 

After installing SAS Activity-Based Management 7.2, re-run the dbupgrade.exe utility to 

migrate your existing users and groups to the SAS Metadata Server. This time, select the option 

entitled, “Migrate existing SAS Activity-Based Management users to…” 

The upgrade utility performs two tasks: 

1. Moves all existing SAS Activity-Based Management 6.x users to the selected metadata 

server and adds them to the necessary groups so they can continue accessing SAS 

Activity-Based Management 7.2 functionality as they did in SAS Activity-Based 

Management 6.4. 

2. Moves any existing SAS Activity-Based Management 6.x roles to the selected metadata 

server as groups along with the users who are members 

The addition required information for migrating the users is: 

(Metadata Server) Machine: Specifies the server name of your metadata server. 

(Metadata Server) Port: Specifies the port number that your metadata server is configured. Port 

8561 is the default value. 
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(Metadata Server) User: An internal metadata server user with administrative privileges. This 

user name will be of the form <MyAdminName>@saspw.  For example, a typical default internal 

administrative user is sasadm@saspw. 

(Metadata Server) Password: Specifies the administrative user’s password.  

Repository: Specifies the repository where the new SAS Activity-Based Management user data 

will be created. Unless there is a specific need, this should be set to Foundation. 

AuthDomain: Specifies the authentication domain. The default value is DefaultAuth and is 

typically used. 

Microsoft SQL Server 

 

Oracle 
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Published Reports 

In Chapter 3 you backed up your existing published reports. In SAS Activity-Based Management 

6.x the published reports were stored in a directory on the Mid-Tier Server. In SAS Activity-Based 

Management 7.2 they are still stored on the Mid-Tier Server, but they are now in a different 

directory. They are now located in: 

Windows:

 <CONFIGHOME>\Applications\SASActivityBasedManagement7.2\publish 

UNIX:  
 <CONFIGHOME>/Applications/SASActivityBasedManagement7.2/publish 

Please copy the published reports from their backup location into the folder specified above. Also 

follow the instructions in “Publish Reports Permissions” to properly set access privileges. 

Recalculating Models 

SAS Activity-Based Management 7.2 (and 7.1)  added a new feature which allows users to control 

the order that accounts appear in the SAS Activity-Based Management client application and in 

OLAP cubes. However, this new feature requires the presences of additional data in the fact 

tables.  

Of course, the fact tables from 6.x versions of SAS Activity-Based Management don’t have this 

required data. So, the dbupgrade utility marks the Calculate Status of all period/scenario 

combinations in all models migrated to 7.2 (and 7.1) as “Not calculated”. This is necessary 

because the required additional data is generated during the calculation process.  

 

You can still view your current calculation results without re-calculating. You can also view your 

current OLAP cubes without re-calculating or re-building your cubes if you used SQL Server 

Analysis Services 2005 or just upgraded to SQL Server Analysis Services 2008 for OLAP 

processing in SAS Activity-Based Management 6.x. However, if you want to rebuild only the 

cube or re-create the fact tables, SAS Activity-Based Management will also perform a calculation. 

Tip:  The fact table generation algorithm in SAS Activity-Based Management 7.2 is more efficient 

than the one in prior versions when creating Multi-Stage Contributions. It produces 

equivalent results and identical OLAP cubes, but can often do so with fewer, sometime 

substantially fewer, rows in the fact table. This is especially true if you are running the SAS 

Activity-Based Management Calculation Server on a 64 bit operating system. These 

improvements usually translate into smaller fact tables, decreased fact table creation times, 

and decreased cube building times. 

Data Import and Export Configurations 

SAS Activity-Based Management 7.2 has a Java-based mid-tier; SAS Activity-Based Management 

6.x had a C++/C#-based mid-tier. Due to this change, SAS Activity-Based Management 7.2 
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primarily uses JDBC connections to data sources where SAS Activity-Based Management 6.x 

used ODBC data sources. 

The Model Data Import configurations, Model Data Export configurations, and Report Data 

Export configurations all need to have their data sources re-created. You can update the data 

source by opening each configuration, hence launching the appropriate wizard, and re-attaching 

to your data source using one of the several available methods. 

 

For more information about the available options when creating data sources, see the topic 

“Connect to a Database” in the SAS Activity-Based Management 7.2 online Help. 

Published Reports Permissions 

SAS requires that each user of SAS Activity-Based Management have proper access to the 

publish directory. Any user who wants to create or delete published reports must have 

sufficient privileges on that directory and report file to perform that operation. Any user who 

wants to read published reports must have read privileges on that report. These access privileges 

are granted by the host operating system and are not managed by the SAS metadata server. 

Windows 

1. Open Windows Explorer on the SAS Activity-Based Management Mid-Tier Server and 

browse to the published reports folder at: 
<CONFIGHOME>\Applications\SASActivityBasedManagement7.2\publish 

2. Make sure the publish folder is visible is the left-hand pane. Right-click on it and select 

Properties… 

3. Select the Security tab. 

4. Make sure each SAS Activity-Based Management user who creates published reports has 

Modify, Read, and Write access to the directory. When you select Modify, Read & 

Execute and List Folder Contents are also selected. Also make sure each SAS Activity-

Based Management user who reads published reports has Read access to the directory. 

 

or 
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UNIX 

1. Navigate to the directory where published reports are created on the SAS Activity-Based 

Management Mid-Tier Server at: 

<CONFIGHOME>/Applications/SASActivityBasedManagement7.2/publish. 

2. Create a sub-directory inside the SASActivityBasedManagement7.2 directory 

named publish if one does not already exist. 

3. Make sure each SAS Activity-Based Management user who publishes reports has Read, 

Write, and Execute access to the directory. Also make sure each SAS Activity-Based 

Management user who views published reports has Read access to the directory 

4. Each user who publishes reports must be part of the SAS Servers Users group. However, 

this was already set up in Chapter 4 when you set up the SAS Server Users group. 

5. Execute the following command to change permission on the directory: chmod 771 

<CONFIGHOME>/applications/SASActivityBasedManagement7.2/publish. 

6. Finally, the default security for files created is 755 or lower, so add a umask 

771command  in the .sh file that launches the SAS Workspace Server on your 

Calculation Server so that files created in the publish folder will have the proper 

permissions. 

Creating SAS Activity-Based Management Users 

Each SAS Activity-Based Management user needs an account in the SAS Metadata server. Before 

you run SAS Activity-Based Management, you will need to create at least one SAS Activity-Based 

Management user. You may add just one user now, or you may want to add all users. For 

information on adding users please see the SAS 9.3 Intelligence Platform Installation and 

Configuration Guide. 

Now that you have at least one SAS Activity-Based Management user created in the Metadata 

server, we can create the necessary group(s) and role(s) to manage the users who are authorized 

to run SAS Activity-Based Management. Each authorized user does not necessarily have the same 

feature access privileges, or capabilities, in SAS Activity-Based Management. Each user who wants 

to run SAS Activity-Based Management needs three items in the SAS Metadata server: 

1. an internal user account (on the Metadata server) 

2. belongs to a role which provides at least one SAS Activity-Based Management capability 

3. belongs to the “Activity-Based Management Users” group 

We will start by creating a role for the users who have full access to the model building features 

of SAS Activity-Based Management, the Create Models capability. For more information on user 

capabilities, see “User Capabilities and Groups” in the SAS Activity-Based Management client 

Help. 

Tip:  If you aren’t ready to add your SAS Activity-Based Management users to the Metadata 

Server yet, you may use your SAS First User account instead. 

Configuration-Created Metadata 

The SAS Activity-Based Management configuration process creates four roles, six groups and one 

library in the SAS Metadata server.   

The four roles are: 
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1. Activity-Based Management: View Models 

2. Activity-Based Management: Create Models 

3. Activity-Based Management: Administration 

4. Activity-Based Management: Take Surveys 

The four roles are pre-created to provide a common set of capabilities for you to use when 

configuring your installation. You may create as many additional roles as needed to customize 

your deployment. 

The six groups are: 

1. Activity-Based Management Users (an “umbrella” group for all Activity-Based 

Management users) 

2. Activity-Based Management Cube Creators (for SAS OLAP users who create cubes) 

3. Activity-Based Management Viewers 

4. Activity-Based Management Modelers 

5. Activity-Based Management Administrators 

6. Activity-Based Management Survey Takers 

The first group, “Activity-Based Management Users” contains either directly as users or 

indirectly via other groups, all the users who are authorized to use the SAS Activity-Based 

Management product.  

The second group, “Activity-Based Management Cube Creators”, contains either directly as users 

or indirectly via other groups, all the users who will create SAS OLAP Server cubes. Users who 

have the Create Models and Create Cubes capabilities must belong to this group. If you are not 

using SAS OLAP Server to create your cubes, you may ignore this group. 

The remaining 4 groups are pre-created to provide a common placeholder for users when you 

configure your installation. You may create as many additional groups as needed to customize 

your deployment. 

The one library is: 

1. ABM Library 

Finally, the “ABM Library” library reference in the Data Library Manager is used by the SAS 

OLAP Server to store information about your cubes. 

Creating an Activity-Based Management Role 

1. Open the SAS Management Console using a SAS administrative user. 

2. Click on the Plug-ins tab at the top and select the Foundation repository.  

3. Expand Environment Management folder. There should already be a role named 

“Activity-Based Management: Create Models” present. If there isn’t, create one. 

a. Right mouse click on the User Manager and select New→Role. 

b. Add a Name for the role. SAS recommends “ABM: Create Models” with a 

Display Name of “Activity-Based Management: Create Models”. 

4. Select the Capabilities tab and expand the Activity-Based Mgmt 7.2 folder 

5. Check the Create Models capability. 
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6. Click on OK to save the role. 

7. Repeat steps 3 through 6 for the roles, “Activity-Based Management: View Models”, 

“Activity-Based Management: Administration”, and “Activity-Based Management: Take 

Surveys”. 

Creating an Activity-Based Management Group 

Now create a group to hold all the users who will have the SAS Activity-Based Management 

Create Models capability. 

1. Open the SAS Management Console using a SAS administrative user if it is not already 

open. 

2. Click on the Plug-ins tab at the top and select the Foundation repository.  

3. Expand Environment Management folder. If there is not a group named “Activity-Based 

Management Modelers” present or one you want to use, create one. 

a. Right mouse click on the User Manager and select New→Group. 

b. Add a Name for the role. SAS recommends “ABM Modelers” with a Display 

Name of “Activity-Based Management Modelers”. 

4. Add the “Activity-Based Management: Create Models” role to this group, if necessary. 

a. Select the Groups and Roles tab. 

b. Add the “Activity-Based Management: Create Models” role by moving it from 

the Available Groups and Roles left-hand list to the Member of right-hand list. 

5. Now add the SAS Activity-Based Management users to this group that you want to have 

this set of capabilities.  

a. Select the Members tab. 

b. Add the desired users to this group by moving them from the Available 

Identities left-hand list to the Current Members right-hand list. 

6. Click OK to save the group. 

7. Repeat steps 3 through 6 for the groups, “Activity-Based Management Viewers”, 

“Activity-Based Management Administrators”, and “Activity-Based Management Survey 

Takers” except replace the linked role in Step 4b with the respective role you created 

earlier. 

Adding a Group to the Activity-Based Management Users Group 

1. Open the SAS Management Console using a SAS administrative user if it is not already 

open. 

2. Click on the Plug-ins tab at the top and select the Foundation repository.  

3. Expand Environment Management folder. 

4. Select the User Manager folder. 

5. Select the group “Activity-Based Management Users” and view its properties. 

6. Select the Members tab 
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7. Add all the groups you created in the previous section to this group (except this umbrella 

itself) as you did in Step 4 in the previous section. 

8. Click on OK to save the group. 

To summarize: To allow users to run SAS Activity-Based Management and assign their 

capabilities (i.e. access to features with SAS Activity-Based Management) we performed four 

basic steps: 

1. We created a role with the desired capability or capabilities. 

2. We created a group and added the new role to it so all the users in that group will have 

access to those capabilities. 

3. We added all the SAS Activity-Based Management users we wanted to have this set of 

capabilities to the group. 

4. We added this new group to the “Activity-Based Management Users” group so they can 

run the SAS Activity-Based Management software. 

If this deployment is using SAS OLAP Server to create cubes, you should also add the “Activity-

Based Management: Create Models” group to the predefined “Activity-Based Management Cube 

Creators” group so they can build SAS OLAP cubes. 

Similarly you can create other groups and roles to manage different roles (with different 

capabilities or combinations of capabilities) and the users who use them.  

Tip:  SAS recommends that roles contain an active name. For example: “Activity-Based 

Management: View Models”, or “Activity-Based Management: Administration”. The 

product name should prefix the active name with a colon separator. This helps manage the 

diverse products, capabilities, and users in your SAS Metadata Server by partitioning them 

logically. Additionally, SAS recommends that groups contain a user’s activity. For example, 

“Activity-Based Management Administrators” without a colon separator. 

Setting Up Metadata Users for Mixed Architecture Environments 

If you use both Windows and UNIX servers in your SAS Activity-Based Management 

deployment, then you need to ensure that the SAS Activity-Based Management users have logins 

for both machines. The authentication domains are defined when you create the servers in 

metadata. 

 

 

Validating the SAS Activity-Based Management Solution 

SAS Activity-Based Management 7.2 ships with a two diagnostics utilities. One is installed with 

the client and the other is installed on the SAS Activity-Based Management mid-tier.   
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Client Diagnostics 

The client diagnostic application is available on the Start menu at All Programs→SAS→SAS 

Activity-Based Management 7.2→Tools→SAS Activity-Based Management Client Diagnostic. 

The client diagnostic tool validates many aspects of the SAS Activity-Based Management client 

installation. Verify that all tests pass successfully. These validation suites execute very quickly 

and take only a few seconds to run. 

The client diagnostic application also provides a System Information report that provides 

deployment and version information. The System Information report must run as an authorized 

SAS Activity-Based Management users. You will be prompted to login when you run the report. 

Server Diagnostics 

Start the server diagnostics from the Start menu at All Programs→SAS→SAS Activity-Based 

Management →Tools→Diagnostic 7.2 in Windows or an executable named <SASHOME>/ 

SASActivityBasedManagementServer/7.2/ServerDiagnostic on UNIX. On UNIX, the Activity-

Based Management Server Diagnostics is an X window application. If you are running from a 

personal computer, you need to set up the display to the computer. An example of this is: 

DISPLAY=<your_machine_absolute_address>:0.0 

export DISPLAY 

The diagnostics utility does two types of things.  It verifies on the machine that it is running that 

the correct code and permission are defined.  And additionally it communicates with the web 

server to determine if the permissions are set up correctly for SAS Activity-Based Management.  

If you have problems invoking the diagnostics, you should open the ServerDiagnostic.ini file. It is 

located in the folder above the diagnostic executable folder as follows: 

Windows:     <SASHOME>\SASActivityBasedManagementServer\7.2   

UNIX:     <SASHOME>/SASActivityBasedManagementServer/7.2  

Check for the following lines: 

1. JavaArgs_4=-Dsas.app.class.path="<fully qualified name of  
junit.jar>" 

If the name is not specified, then supply it with the fully qualified name of the junit.jar  

2. JavaArgs_9=-Denv.definition.location=”< fully qualified name of 
the SAS-environment file>” 

If the name is not specified or the diagnostics say it cannot find the xml file, then supply 

the fully qualified name of the sas-environment.xml file.  It is usually located in 

    <CONFIGHOME>\Web\Common 

You can update the following line to create a log: 

               applogloc=launcher.log 

The following picture shows the first dialog of the diagnostic utility.  

The diagnostics will prompt you for a modeler login and other details. If your servers are of 

mixed architecture, then you must fully qualify the name of the metadata server. 
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You may select the specific tests you want to run using the check boxes or enable all tests using 

the Set all tests button at the bottom of the window. 

The log can be saved to the local machine.  The file names are displayed in the window after the 

report is saved. On Windows the default location for this log is C:\Documents and 

Settings\<UserID>\SAS\SAS Activity-Based Management Diagnostic\7.2.  On 

UNIX the default location for this log is /SAS/SAS Activity-Based Management 

Diagnostic/7.2. 

The second tab displays information about your system. 
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Appendix A – Installing Microsoft SQL Server 

Installing Microsoft SQL Server 2008 

When installing Microsoft SQL Server 2008 you may choose the default values with a few notable 

exceptions that are documented below. 

Verification of an Existing Version 

If you already have SQL Server 2008 installed. Verify that the correct version and service pack is 

installed. 

1. Launch the SQL Server Management Studio from the Start menu. 

2. Make sure you have selected Database Engine and the computer where your Database 

Engine is running. Log into SQL Server Management Studio using an appropriate 

administrative account. 

3. Open a query window by selecting the New Query toolbar button or by selecting New→ 

Query with Current Connection from the File menu. 

4. Paste the following query into the query window: 

SELECT SERVERPROPERTY('productversion'), SERVERPROPERTY 

('productlevel'), SERVERPROPERTY ('edition') 

And choose Execute. 

5. The version number should appear similar to 2007.1100.2531.0 or 10.0. 2531.22 depending on 

how you installed SQL Server 2008 and how SP1 was added. The key point is that the 

numerical version should be 2531or higher. This signifies Service Pack 1 or newer. 

Warning:  The version of the database engine cannot be checked using the About dialog in SQL Server 

Management Studio. The version reported in the About dialog is the client software version, not 

the database engine version. 

Installation 

Begin installing SQL Server by launching setup.exe, usually contained in the root of the DVD. 

The minimum features SAS Activity-Based Management requires on the Database Server are: 

 SQL Server Database Services 

 Analysis Services (if you are using SQL Server Analysis Services for OLAP and if your 

Database Server and OLAP Server are on the same computer). 

 Client Tools Connectivity 

 Workstation Components 

Additionally, SAS recommends installing the Workstation Components on the Mid-Tier Server. This 

allows users to administer the database engine remotely from the Mid-Tier Server. 



77 

 

 

You can make this the default SQL Server database instance on this computer or you may create a 

named instance. SAS Activity-Based Management works properly with SQL Server installed either 

way. If you choose to create a Named Instance, SAS recommends the name AbmSqlInstance. 
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Select NT Authority\System for the services and provide password for the Service Accounts tab on 

the Server Configuration wizard dialog. 
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Select a default collation sequence for this SQL Server installation. The default collation sequence for 

SQL Server is “SQL_Latin1_General_CPI_CI_AS” is acceptable for North American installations. 

Regardless of which collation sequence you choose, you must choose a case insensitive collation. This 

is important because SAS Activity-Based Management does not distinguish between 

MyAccountName, MYACCOUNTNAME, and myaccountname. 

 

 

Select Mixed Mode Authentication and enter a password for the local system administrator account 
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Installing Microsoft SQL Server Analysis Services 

Installation 

Only Analysis Services is required. 

Configuration 

Additionally, it is necessary that the Database Server can resolve the OLAP Server’s name, and vice-

versa. This is necessary for the communication between the two computers to be handled properly 

and for the SQL Server Management Studio to communicate properly with the SQL Server instance 

running on the Database Server. The most common difficulty arises when the Database Server and the 

OLAP Server are in different domains. Either the two servers need to be able to authenticate each 

other or authentication needs to be turned off.  If this is necessary, follow the following steps: 

1. Open Administrative Tools in the Control Panel. 

2. Open Component Services. 

3. Select Component Services→Computers→My Computer, right-click, and choose Properties. 

4. On the MSDTC tab choose the button labeled Security Configuration. 

5. Select the option under Transaction Manager Communication that is appropriate for your 

installation. You may need to select the option labeled No Authentication Required. 

Validation 

Optionally, you can validate that the Microsoft SQL Server Analysis Services tools and components 

are installed correctly and that you have the proper permissions for the user SSAS user that will be 

used by SAS Activity-Based Management.  

Depending on where you are in your installation process, you may not be able to complete all these 

steps now. If you can’t complete them now, you can finish the SAS Activity-Based Management 

installation and return to these validation steps later. 

On the computer where you installed Microsoft SQL Server Analysis Services: 

1. Log into the server where the SSAS is installed as the SSAS OLAP user that SAS Activity-

Based Management will use. 

2. Start SQL Server Management Studio and connect to the analysis server. 

3. Verify that in addition to connecting, you can browse an existing cube. A sample cube that is 

installed by Microsoft will suffice. 

If any part of that doesn’t work, then there is a problem in your SSAS server installation. 

On the computer where you installed the SAS Activity-Based Management mid-tier: 

1. Log onto the server where ABM mid-tier is installed as the SSAS OLAP user that SAS 

Activity-Based Management will use. 

2. Start SQL Server Management Studio and connect to the analysis server. 

3. Verify that in addition to connecting, you can browse an existing cube. 
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If you can’t log into the SSAS server, then the permissions related to your OLAP user are incorrectly 

configured. If you can log into the server but are unable to browse a cube, then the Client Tools for 

SSAS are not installed properly on the mid-tier server. In particular, make sure that the Microsoft 

AMO tools are installed – that is what SAS Activity-Based Management uses to communicate with 

the SSAS server. 

Configuring Microsoft SQL Server 2008 

JDBC Driver 

The Microsoft SQL Server JDBC Driver 3.0 driver works properly with SQL Server 2008 and is 

suitable for use with all supported web application servers and is available from the Microsoft 

website at http://www.microsoft.com/downloads/details.aspx?FamilyID=a737000d-68d0-4531-b65d-

da0f2a735707&displaylang=en#RelatedDownloads. 

Create the SAS Activity-Based Management User 

If this is a new installation of SAS Activity-Based Management, you will create a Microsoft SQL 

Server database and a user that will execute queries generated by SAS Activity-Based Management. 

You will also assign the appropriate access privileges for this user to the new database that will 

contain the SAS Activity-Based Management data. 

You need to create a SQL Server Database and an Administrator User id.   

1. Open the SQL Server Management Studio program on the Database Server.   

2. Right-click on Databases and select New Database. The recommended database name is 

sasabmmodels. The database initial size/autogrow settings and the transaction log initial 

size/autogrow settings have default values that are very small and will hamper performance. 

The default settings should be changed to suit your expected data volumes. This 

sasabmmodels database has an initial size of 500MB and an autogrow size of 500MB. The 

transaction log has an initial size of 50MB and an autogrow size of 50MB. These settings are 

appropriate for small- to medium-size data volumes. 

 

http://www.microsoft.com/downloads/details.aspx?FamilyID=a737000d-68d0-4531-b65d-da0f2a735707&displaylang=en#RelatedDownloads
http://www.microsoft.com/downloads/details.aspx?FamilyID=a737000d-68d0-4531-b65d-da0f2a735707&displaylang=en#RelatedDownloads
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3. Click OK to create the sasabmmodels database. 

To create the database Administrator account: 

1. Expand the Security folder. Right-click on Logins and choose New Login.  

2. Enter the user name in the Login Name edit field. SAS recommends sasabmuser.  

3. Choose SQL Server Authentication and enter a Password. Choose a password that adheres 

to your company’s password naming policy. 

4. Select sasabmmodels for the Default database. 

 

5. Select Server Roles in the upper left-hand pane. Select Bulk Admin from the list of server 

roles in the right-hand pane. 
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6. Select User Mapping from the upper left-hand pane. Select the check box for sasabmmodels 

in list of models in the upper right-hand pane. Select the check box for db_owner in the list of 

database roles in the lower right-hand pane. 

 

7. Click OK to create the new user and its database assignments. 

Environment Variables 

You need to create an environmental variable BCP_HOME on the Mid-Tier Server computer to point 

to bcp.exe which was installed as part of the SQL Server Management Tools. For example, follow 

these steps if you installed the client tools at C:\Program Files\Microsoft SQL Server\.  

a) Open the System dialog box via StartControl PanelSystem.  

b) Open the Advanced Tab and click Environment Variables. 

c) Under System Variables, highlight BCP_HOME and click Edit. If BCP_HOME does not exist, 

click New. Enter the path to the client tools, normally C:\Program Files\Microsoft SQL 

Server\100\Tools\Binn for SQL Server 2008. 

d) Click OK for each of the windows opened. 

Important:  If you have any open DOS prompts, please close and re-open them to pick up environment 

changes. Type in the DOS Set command without any parameters and verify the setting for 

BCP_HOME. If it is still not set then reboot the system. 

Also, record the database name, database user name, password, and the configured port in the table 

at the top of Chapter 5. 
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Appendix B – Installing Oracle 11g 

These instructions are intended for installing Oracle 11g on Windows. Oracle 11g installation on 

UNIX may vary due to operating system differences. These instructions, particularly the Oracle Net 

Configuration portions, do not state that this is the only way to create a working Oracle 11g 

installation with SAS Activity-Based Management. Instead, they provide a sample of the installation 

choices that SAS used to install Oracle 11g. The choices that are mandatory are specifically noted. 

Oracle databases have numerous configuration options which can be tuned to maximize performance 

in different environments and for different usage patterns. Unless you are an experienced Oracle 

administrator, SAS recommends that you do not stray from the following recommendations. Doing 

so may result in a non-working or partially-working installation. 

Warning:  SAS validated the following installation and configuration options for Oracle 11g. Many other 

options are available for an Oracle deployment.  

Installing Oracle on Windows 

Begin installing Oracle 11g by double-clicking on the setup.exe to begin the installation process. 

1. Select the Advanced Installation option and click Next. 

 

2. Choose the Installation Type based upon your need. Click Next. 

3. The Install Location dialog displays. This dialog determines the Oracle Base location (the 

installation path), and the Oracle Home name and path. These locations are important and 

will be referred to often in Oracle’s documentation. The <MyOracleHomeName> is important 

for SAS Activity-Based Management because it determines how the Oracle data sources 

appear in the Windows ODBC Data Source Administrator dialog. The 

<MyOracleHomeDir> is used later in the configuration process to create the 

ORACLE_HOME environment variable to locate the Oracle bulk load utility. Click Next. 
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4. Verify that all the Product-Specific Prerequisite Checks are marked Succeeded. These 

checks are very important. Pay close attention to any warnings or errors and correct them 

before proceeding. Also verify that there are “0 requirements to be verified.”  

Warning: The Oracle installer performs a few prerequisite tests. Make sure all tests successfully 

complete. If any tests fail, refer to the Oracle installation guide for help. This is especially 

important because depending on your hardware configuration, the Oracle database may 

require the presence of a Loopback Adapter for proper operation. If the Loopback Adapter is 

not installed but its presence is required by Oracle, the Oracle database will appear to 

operate properly most of the time. However, SAS has determined that random failures, 

typically involving “concurrency” (to quote the Oracle error messages), will occur. The 

Oracle documentation has instructions for installing the Loopback Adapter on your 

operating system. 

In particular, the Oracle prerequisite checks might identify a problem with the DHCP 

configuration of your host Computer. The error displays as: 

Checking Network Configuration requirements... 

Actual Result: :java.lang.NullPointerException:Exception/Error Occurred 
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Oracle supports systems with DHCP-assigned IP addresses, but you may need to perform 

additional configuration steps on your computer before proceeding. You may need to install 

a loopback adapter and configure it to be the primary network adapter. Search for the string 

“DHCP” in the Oracle Database Installation Guide for more details on installing the Oracle on 

systems configured with DHCP.  

Click Next if all the tests succeed. Otherwise, cancel the installation and resolve the problems 

before proceeding. 

5. Select Create a Database. Click Next. 

6. Select Advanced database configuration. Click Next. 

7. Click Install to begin installing the Oracle database engine. A progress dialog displays. 

8. A Database Configuration Assistant wizard displays. The first wizard step might display 

behind the main wizard dialog. Select General Purpose or Transaction Processing. Click 

Next. 

9. Choose a Global Database Name (GDB) and a SID for your database. The standard Oracle 

convention for the formatting the GDB name is <SID>.<MyDomain> where <SID> is the 

name you gave the SID. Click Next. 

10. Select Configure Enterprise Manager. SAS recommends you also choose to Configure 

Database Control for local management. Click Next. 

11. Choose a password for the administrative account. Click Next. 

12. Select the Storage Management option that suits your installation. Click Next. 

13. Select the location for database files. Click Next. 

14. Select the recovery options for the database. Click Next. 

15. Uncheck the Sample Schemas option unless you want them for reference. Click Next. 

16. The next wizard page dialog has 4 tabs. Click on the Sizing tab. Make sure the number of 

Processes is large enough to service the expected work load from the SAS Activity-Based 
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Management users. An estimated number of processes is difficult to gauge. The Oracle 

database may divide large queries into multiple smaller ones that execute in parallel – with 

each sub-query consuming a process. Thus, the number of needed processes is not directly 

tied to user load or query load. The default value is typically 150. 

Click on the Character Sets tab. Select Use Unicode. 

Click on the Connection Mode tab. Select Shared Server Mode to avoid concurrency 

problems, and pick the appropriate number of server processes. The proper value depends 

on the capability of your computer. If you select Dedicated Server Mode, you have to 

register the database (SID) with Oracle listener after installing to avoid concurrency 

problems. SAS recommends Shared Server Mode. Click Next. 

 

Warning:  SAS has encountered intermittent failures relating to “concurrency” problems when the 

Dedicated Server Mode is selected. If your deployment requires the Dedicated Server 

Mode, please follow the instructions in the Oracle Database Installation Guide for 

registering the database SID. This appears to resolve the problems. SAS Activity-Based 

Management will generate errors during certain multi-user operations if the database 

SID is not registered. 

17. Select keep the enhanced security settings. Click Next. 

18. SAS recommends selecting the Enable automatic maintenance tasks option. You may 

change this option if required for your deployment. Click Next. 

19. Click Next on the Database Storage dialog. 

20. Click Finish on the Database Creation dialog. A confirmation dialog displays. Click OK if 

you are satisfied with your selections. 

21. Click Exit when the Database Configuration Assistant dialog displays. 
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22. Click Exit when the Oracle End of Installation dialog displays. 

 

 

Configuring Oracle 

JDBC Driver 

The JDBC driver for Oracle 11g is included as part of the Oracle Client installation. The Oracle 

installation process puts it at <OracleClientDirectory>\sqlj\lib\jdbc\lib\ojdbc5.jar 

on Windows systems. This driver is needed on the Mid-Tier Server. SAS recommends the Oracle 

Client be installed on the Mid-Tier Server to provide this driver. If necessary, this driver can be 

downloaded directly from Oracle’s website at 

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.html.  

Important:  SAS recommends installing the JDBC drivers using the Client Tools options on your Oracle 

installation CDs. This guarantees that the Application, and hence the JDBC drivers, will receive 

any updates as part of a database update provided by your vendor. Additionally, the Mid-Tier 

Server uses the Oracle SQL*Loader (bulk loader) to improve performance for the data import 

process. The bulk loader is also part of the Client Tools installation. 

Environment Variables 

 Windows 

You need to create an environmental variable ORACLE_HOME on the Mid-Tier Server to point to the 

client tools installation directory. The client tools will be installed at <MyOracleHomeDir>. For most 

deployments where the client tools are installed this will be the client_1 directory. If only the 

database engine is installed, and not the client tools, the location will be the db_1 directory. For 

example follow these steps if you installed the client tools at 

C:\Oracle\product\11.1.0\client_1. 

1. Bring up the System dialog box via StartControl PanelSystem. 

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.html
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2. Open the Advanced Tab and click Environment Variables. 

3. Under System Variables, highlight ORACLE_HOME and click Edit. If ORACLE_HOME 

does not exist, click New. Enter the path to the client tools, normally 

C:\Oracle\product\11.1.0\client_1. 

4. Click OK for each of the windows opened. 

See the discussion of Oracle Home in “Installing Oracle 11g” earlier in this section. 

Important:  Please close and reopen DOS prompts to pick up environment changes. Issue the set command 

without any parameters and check for ORACLE_HOME. If it is still not set then reboot the 

system. 

UNIX 

The following commands set the ORACLE_HOME environment variable on UNIX. These statements 

can be added to the .profile file of the user that is running the installation. Alternatively this can be 

added to a common profile accessed by the user’s profile. 

For example if you installed Oracle in the usr directory, issue the following commands: 

ORACLE_HOME=/usr/Oracle 

export ORACLE_HOME 

Create the TableSpace 

The TableSpace is the file where your data is stored in your database. SAS recommends that you 

create a tablespace for SAS Activity-Based Management that is not shared with other applications. To 

create a tablespace in Oracle 11g, run Database Control for the SID you created. It is available on the 

Start menu under your Oracle installation. In the screen image below, “Database Control – Ora11g” 

is highlighted. Ora11g is the SID. 

 

Tip:  The Oracle Database Control is a web application in Oracle 11g. Depending on the security 

settings of your web browser, you may not be able to access the Oracle web page. If you 

encounter difficulties, go to the Security tab on Tools→Internet Options and add the Oracle 

web site to the list of trusted sites.  

1. Log in to the Database Control application using the administrative user and password you 

created in the previous section. 

2. Click on the Server tab. 

3. Under the Storage subsection, click on TableSpace. 

4. Click Create. It is on the right-hand side of the screen. 
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5. Enter a name for your tablespace. SAS suggests TS_SASABM. Accept the other default 

values. Click on the Add button to add this new tablespace.  

 

6. Enter a name for the tablespace file. SAS suggest using the tablespace name with a suffix of 

.dbf (which is standard for tablespace file names in Oracle). Set the initial file size and 

increment size for your deployment. Click Continue. 

 

7. The tablespace creation is complete. Click OK. 

Create the SAS Activity-Based Management User 

1. Select Users from the Security subsection of the Server tab. 
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2. Click Create. It is on the right-hand side of the screen. 

 

3. Enter the new name of the database user who will access the TS_SASABM tablespace. SAS 

recommends SASABMUSER. Enter a password for this user. Make sure the default 

tablespace is TS_SASABM, or the name you chose when the tablespace was created, and the 

TEMP tablespace for temporary work. 

 

4. Select the System Privileges tab. Click Edit List. Add the following seven privileges to the 

Selected System Privileges list: Create Procedure, Create Sequence, Create table, Create 

Trigger, Create View, Query Rewrite, and Unlimited Tablespace. Click OK. 
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5. The user creation is complete. Click OK. 

 

Oracle Net Configuration 

You need to create identical Oracle Net Service Names (Alias) on the following computers: Mid-Tier 

Server, Calculation Server, and the computer where you run the SAS Activity-Based Management 

Database Upgrade Utility. If two or more of these logical computers map to a single physical 

computer, then the computer only needs a single Net Configuration. 

Oracle uses aliases to facilitate communication with the Oracle database. The Oracle Net Manager 

utility is used to create aliases. It is available on the Start menu under your Oracle installation. 

 

1. When the Net Manager displays, expand the Local node in the left-hand pane. 

2. Click on Profile. The allowed connection methods display in the right-hand pane. Verify the 

Methods tab is selected. Verify that TNSNAMES and EZCONNECT are displayed in the 

Selected Methods list box. 

3. Expand Service Naming. Click the green plus sign or select Edit→Create. 
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4. The Net Service Name Wizard displays.  Enter a name for your Net Service. SAS 

recommends the name ABMDSN. You must choose a name that is the same as the DSN name 

you will create in Chapter 8. This is necessary because the SAS Activity-Based Management 

calculation engine uses both a DSN and a Net Service Name to load data into the Oracle 

database. It assumes the Net Service Name is the same as the DSN name Click Next. 

Note:  Oracle documentation sometimes refers to the Net Service name as a Net Configuration 

name or an Alias name. 

5. Page 2 of the wizard displays. Verify TCP/IP (Internet Protocol) is selected. Click Next. 

6. Page 3 of the wizard displays. Enter the Host Name where the Oracle database is installed 

and the Port Number it is configured to use. Click Next. 

7. Page 4 of the wizard displays. SAS recommends that the Service Name option be used. The 

SID option is for backward compatibility. In the Service Name option, enter the Global 

Database Name you used in Step 9 in the “Installation” section. This is your 

<MyGlobalDatbaseName>. You may use the SID option when the Oracle database is on 

UNIX but it is not recommended for use on Windows. Click Next. 

 

8. Page 5 of the wizard displays. Click the Test… button to verify the connection.  

9. The Connection Test dialog displays. You may need to click Change User… before selecting 

the Test button depending on which login you used when you created the Global Database 

Name. When you click the Test button, you should see the message “The connection test was 

successful.” Click Close. 

10.  You are taken back to Page 5 of the wizard.  Click Finish. 

11. You must save the alias you just created by selecting File→Save Network Configuration 

before you exit the application. The Net Configuration is complete. 

Verify the port that your Oracle database installation is configured to use. Update the Database 

Server table at the beginning of Chapter 5 with the correct information. 

Oracle Database Processes and Sessions 

Depending on how your Oracle database was installed, the default settings for the number of 

available database connections and sessions may need to be changed. You can query the currently 

defined settings using the following commands: 
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SHOW PARAMETERS PROCESSES; 

SHOW PARAMETERS SESSIONS; 

If the number of process and settings is less than 200, it should be increased to at least 200, which is 

the Oracle recommended minimum values. SAS recommends 250. The settings can be changed using 

the following commands: 

ALTER SYSTEM SET PROCESSES=250 SCOPE=SPFILE; 

ALTER SYSTEM SET SESSIONS=250 SCOPE=SPFILE; 

SHUTDOWN IMMEDIATE; 

STARTUP; 

These series of commands update the settings and restart the Oracle instance so the new settings will 

take effect.  

The Oracle error ORA-12516, TNS:listener is often found in the Oracle log when either of these two 

settings are exceeded. 

SAS/ACCESS for Oracle Configuration 

SAS/ACCESS for Oracle is needed for the Oracle database to work with the SAS Activity-Based 

Management calculation process. SAS/ACCESS for Oracle must be properly installed and configured 

on your Calculation Server. 
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Appendix C - Installing MySQL 

These instructions are intended for installing the MySQL database on Windows. MySQL installation 

on UNIX may vary due to operating system differences. These instructions have been verified by SAS 

to work with SAS Activity-Based Management and other SAS solutions, such as SAS Financial 

Management, that support MySQL as a relational database. SAS Activity-Based Management 7.2 

supports MySQL primarily to simplify software deployments where multiple SAS solutions share a 

MySQL database installation.  

If your site is installing only SAS Activity-Based Management, SAS recommends the better-

performing Microsoft SQL Server and Oracle 11g relational databases since they both provide a 

“bulk-data loader” utility which improves performance with SAS Activity-Based Management. 

Installing MySQL on Windows 

Verify that the version of MySQL that you want to use is compatible with SAS Activity-Based 

Management 7.2. This information is provided in the SAS Activity-Based Management 7.2 System 

Requirements.  

Begin installing MySQL by extracting setup.exe from the MySQL zip file. Double-click on the 

setup.exe to begin the installation process. 

1. Click Next until the Setup Type dialog appears. SAS Activity-Based Management requires 

the configuration steps of the Custom installation. Click Next. 

2.  The Custom Setup dialog displays. On Windows, change the installation directory to 

C:\MySQL or another directory of your choice. Click Next. 

Note:  The path to the MySQL database installation should not contain spaces. 

3. The summary dialog displays. Click Install. 

4. Click Next until the Wizard Completed dialog appears. Select the Configure the MySQL 

Server now option and click Finish. 

5. The Configuration Type wizard displays. Click Next. 

6. The MySQL Server Instance Configuration dialog appears. Select Detailed Configuration. 

Click Next. 
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7. The Server Type dialog displays. Select either Server Machine or Dedicated MySQL Server 

Machine depending on your expected usage. As noted in the wizard, you should only select 

Dedicated MySQL Server Machine if no other applications will be run on your Database 

Server. Click Next. 

 

8. The Database Usage dialog displays. Select Transactional Database Only. Click Next. 

9. The InnoDb Tablespace Settings dialog displays. Accept the default values unless you need 

to change to another location. Click Next. 

10. The Concurrent Connections dialog displays. Select the Manual Setting option. A typical 

SAS Activity-Based Management user needs about 5 connections at most for all their 

activities (viewing model, performing a calculation, creating a cube, etc.). More connections 

for each user are necessary if you expect users to multi-task with several models 

simultaneously. For 10 simultaneous SAS Activity-Based Management users, 50 connections 

is sufficient with 100 allowing a buffer. Click Next. 

Note:  Other SAS solutions can share this MySQL database instance. Since they often service 

a larger number of users than SAS Activity-Based Management typically does, SAS 

recommends that the number of connections be increased to 300 if this database will be 

shared with other applications. 

 



97 

11. The Networking Options dialog displays. Select the Enable TCP/IP Networking option. SAS 

Activity-Based Management communicates to databases using TCP/IP only. The default Port 

Number may be changed if necessary for your installation. Select the Add Firewall exception 

for this port. For Windows installations, this opens the specified port in the Microsoft 

firewall (if used) so MySQL will receive connection attempts made from other computers. If 

you use third-party firewalls or an antivirus program that includes a firewall, you will have 

to configure those firewalls to allow MySQL to receive connections yourself. Select Enable 

Strict Mode. Click Next. 

Warning: Making this "exception" in Window’s firewall opens a port on your computer. If your 

computer is connected to a network or the Internet, other computers will be able to 

connect to your MySQL server. 

 

12. The Default Character set dialog displays. Select the Best Support for Multilingualism 

option. SAS Activity-Based Management requires a UTF-8 character set on the host database. 

Click Next. 

13. If you are installing on a Windows computer, the Windows Options dialog displays. If you 

are running on UNIX, please proceed to the next step. Select the Include Bin Directory… 

option. Accept the other default selections. Click Next. 
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14. Enter a password for the root account. Select the Enable root access from remote machines 

option. Click Next. 

15. Click Execute. 

Note:  You may receive a connection error dialog (Error Nr: 2003: Can’t connect to the MySQL 

server on localhost [10061].) Retry until the condition clears. 

If the configuration fails on the ʺStart Serviceʺ step on Windows, perform the following steps:  

a. At the Configuration Wizard prompt, click the Back button.  

b. On the previous screen, click the Next button.  

c. From a command prompt, enter:  
net stop MySQL 

sc delete MySQL 

net start  

This stops the MySQL service, deletes the service, and displays a list of active 

services so you can verify the MySQL service is not present.  

d.  Click Execute again and the service should start successfully.  

Installing MySQL on UNIX 

UNIX Hostname  

The hostname command should return the fully qualified hostname for your servers. Verify this by 

issuing the hostname command:  
% hostname  

yourhost.yourdomain.com  

If your site requires a shortened form of the hostname, be sure to consistently use that name 

throughout your configuration steps.  

MySQL Database Server 5.0.86 Enterprise Edition Installation  

MySQL can be found in your SAS Software Depot or media. For instance, a typical path would be:  

/usr/local/SASSoftwareDepot/third_party/MySQL_Database_Server/5_0_86  

Select the appropriate version depending on your operating system. MySQL must be installed into a 

path with no spaces such as /usr/local/mysql.  

Use the following instructions to install MySQL server on your single server or data tier server.  

1. Change directory to the location where you want to install. In these instructions, /usr/local 

will be used as the default but the location can be any directory. You must have permission 

to create files and directories in this location. Change directories to the installation location:  

shell> cd /usr/local  

2. As the SAS Install user, unzip the installation archive to create the installation directory. Use 

the –p flag on tar to preserve the ACLs on the files and directories. Then create a symbolic 

link to that directory based on the platform:  

AIX : 

shell> gunzip < /path-to-

depot/third_party/MySQL_Database_Server/5_0_86/64-bit_Enabled_AIX/mysql-

enterprise-5.0.86-aix5.3-powerpc-64bit.tar.gz | tar xvpf -  

shell> ln –s /usr/local/mysql-enterprise-5.0.86-aix5.3-powerpc-64bit 

mysql  

Solaris SPARC:  
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shell> gunzip < /path-to-

depot/third_party/MySQL_Database_Server/5_0_86/64-

bit_Enabled_Solaris/mysql-enterprise-5.0.86-solaris10-sparc-

64bit.tar.gz | tar xvpf -  

shell> ln –s /usr/local/mysql-enterprise-5.0.86-solaris10-sparc-64bit 

mysql  

Linux:  
shell> gunzip < /path-to-

depot/third_party/MySQL_Database_Server/5_0_86/64-

bit_Enabled_???/mysql-enterprise-5.0.86-???-x86_64.tar.gz | tar xvpf -  

shell> ln –s /usr/local/mysql-enterprise-5.0.86-???.x86_64bit mysql  

where ??? is either rhel for Red Hat or sles for SuSe  

3. Create the MySQL grant tables where installdir is the path to the installation location 

such as /usr/local/mysql:  
shell> cd mysql  

shell> scripts/mysql_install_db --basedir=<installdir>  

--datadir=<installdir>/data  

4. If you want MySQL to start automatically when you boot your machine, you can copy 

support-files/mysql.server to the location where your system has it’s startup files. 

More information can be found in the support-files/mysql.server script itself.  

5. Verify that the SAS Install user has permission to allocate enough memory with the ulimit 

command:  

AIX: Edit the /etc/security/limits file to update if necessary. The soft data segment 

size in blocks may need to be increased for the default or root user. Re-login or get a new 

shell for these settings to take effect.  

Solaris: Use the limit or ulimit command as the root user to increase the hard limit. 
6. To start the MySQL server, use the following command:  

shell> bin/mysqld --basedir=<installdir> --datadir=<installdir>/data &  

If that command fails immediately and prints mysqld ended, you can find some 

information in the host_name.err file in the data directory.  

7. Grant access by root user. More restrictive permissions will be set later in the install process:  
shell> bin/mysql –-user=root  

mysql> GRANT ALL PRIVILEGES ON *.* TO root@'%' IDENTIFIED BY 

'root' WITH GRANT OPTION;  

mysql> GRANT ALL PRIVILEGES ON *.* TO root@'localhost' IDENTIFIED 

BY 'root' WITH GRANT OPTION;  

mysql> GRANT ALL PRIVILEGES ON *.* TO root@'myhost.mydomain.com' 

IDENTIFIED BY 'root' WITH GRANT OPTION;  

mysql> GRANT ALL PRIVILEGES ON *.* TO root@'myhost' IDENTIFIED BY 

'root' WITH GRANT OPTION;  

mysql> quit  

Note: The SAS Software configuration will remove the MySQL root user account.  

8. You can verify that MySQL is started with the following command.  
shell> bin/mysqladmin --user=root --password=root status  

Uptime: 81160 Threads: 1 Questions: 1 Slow queries: 0 Opens: 11 

Flush tables: 1 Open tables: 5 Queries per second avg: 0.000 

Installing MySQL WorkBench Tools 

Install a version of the MySQL GUI Tools that is compatible with the MySQL database engine you 

installed. Please note that the required version of the database engine may differ between 32-bit and 

64-bit versions of Windows or which version of UNIX your are using. 
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Configuring MySQL 

JDBC Driver 

Simply copy or unzip as necessary the required Connector/J file to a suitable directory on the Mid-Tier 

Server. No other installation or configuration steps are necessary. 

Create the SAS Activity-Based Management Database and User 

1. To secure your database, grant full control to <InstallDrive>:\MySQL and its 

subdirectories to Administrators only.  

2. If other SAS solutions will share the MySQL instance, grant READ, EXECUTE and MODIFY 

access to the “Everyone” group for the <InstallDrive>:\MySQL\bin directory. After you 

finish the installation and configuration of SAS products, you will restrict the permissions. 

Make sure these permissions are inherited by the subdirectories and files.  

Note:  Step 2 is unnecessary if the MySQL database instance is to be used by SAS Activity-Based 

Management only. 

3. Next, create the schema that SAS Activity-Based Management will store it data in. Select All 

Programs→MySQL→MySQL Administrator from the Start menu. 

4. Enter the connection information for your MySQL database. Enter the name of the computer 

where you installed the MySQL database engine in the Server Host field. Enter root as the 

Username and the Password you provided earlier in the MySQL installation process. If you 

altered the default Port for MySQL, you will need to edit that value as well. 

 
5. The MySQL Administrator displays. Select Catalogs from the left-hand pane. A new pane 

displays below the existing left-hand pane. 

6. Right-click in open space in the bottom pane and choose Create New Schema. The Create 

new Schema dialog displays. Enter the schema name you want for SAS Activity-Based 

Management. SAS recommends sasabmmodels. Click OK. 

7. Now create a user to access that database. In the top left-hand pane select User 

Administration. The right-hand pane displays user information. 

8. Click Add new user at the bottom of the right-hand pane. Enter a database user name to 

access the sasabmmodels schema. SAS recommends sasabmuser. Enter a password. Enter 

any other user information that is important for your installation. Click Apply changes. 

9. Select the Schema Privileges tab. Select sasabmmodels from the list of available schemas. 

Select all the listed privileges except Grant. Select Apply changes. 
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10. Exit the MySQL Administrator by selecting File→Close. 

Troubleshooting 

If you attempt to connect to this MySQL instance using a MySQL Administrator on another computer 

and it fails with the following message it is likely that you do not have the proper port open on the 

computer hosting the MySQL database engine. 

 

 

Verify the port that your MySQL database installation is configured to use and update the database 

port information in the table in the previous chapter. 
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Appendix D – Third-Party Migration 

The majority of SAS Activity-Based Management 6.x users are currently using either SAS OLAP 9.1.3 

or Microsoft Analysis Services 2000 for cube creation. If you have already migrated to SQL Server 

Analysis Services 2008 as part of your SAS Activity-Based Management 7.1 upgrade, you may skip 

this entire Appendix. 

Migrating from SAS OLAP Server 9.1.3 or 9.2 

If you did not use SAS OLAP Server to build your cubes with SAS Activity-Based Management 6.x, 

you can skip this section.  

When SAS Activity-Based Management built cubes with SAS OLAP Server 9.1.3 or 9.2, it created two 

types of data. The first is the operating system file representing the physical cubes themselves and the 

second is the metadata content about these cubes in the SAS Metadata Server.  

Deleting SAS OLAP Metadata 

The cubes and information maps created by the SAS OLAP Server are located in the SAS Metadata 

Console with other cubes. 

1. Open the SAS Metadata Console application. 

2. Select the Foundation repository on the Repository: droplist. 

3. Expand the Environment Management folder. 

4. Expand the Authorization Manager folder. 

5. Expand the Resource Management folder. 

6. Expand the By Type folder. 

7. Expand the Cube folder. 
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8. All the cubes created by SAS Activity-Based Management will have a name of the form: 

MXXXX_<SomeName> where XXXX is a number between 1000 and 9999.  

9. You should delete all these using the following steps: Open a Base SAS session by selecting 

All Programs→SAS→SAS 9.3. 

10. Paste the following code into the Editor window. Replace the items in angle brackets with 

information applicable for your deployment. Select the Submit button to execute the code. 

Repeat for each SAS Activity-Based Management cube that is defined in your metadata.  

PROC OLAP cube=<MyCubeName> DELETE; 

METASVR host="<MyMetadataServer>" port=8561 protocol=bridge userid="<MyAdminUser>" 

              pw="<MyAdminPassword>"  

              repository="Foundation" 

              olap_schema="<MyOlapSchemaName>"; 

           RUN; 

Where:  

<MyCubeName> is the name of each cube listed in the metadata server. 

<MyMetadataServer> is the name of the computer hosting your SAS metadata server. 

<MyAdmin…> is the administrative user name and password you provided to the SAS 

Activity-Based Management 6.x configuration utility. 

<MyOlapSchemaName> is the schema name you provided to the SAS Activity-Based 

Management 6.x configuration utility. 

11. This process also deletes the physical cube, if it exists, so you may skip the next section. 
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Deleting SAS OLAP Cubes 
The OLAP cubes are stored as files on the operating system. Simply deleting the files will delete the 

cubes. The cubes are stored in the directory you specified when you selected the SAS OLAP Server in 

the SAS Activity-Based Management 6.x Server Configuration utility (if you are migrating from SAS 

Activity-Based Management 6.x) or the directory you specified in the SAS Deployment Wizard while 

configuring the SAS OLAP Server (if you are migrating from SAS Activity-Based Management 7.1). 

By default, this directory is at: 

C:\SAS\Config\Lev1\AppData\SASActivityBasedManagementx.x\cubes where x.x 

should be replaced by the version of SAS Activity-Based Management you are migrating from. This 

value will typically be 6.4 or 7.1. 

Rebuilding SAS OLAP Cubes 

After completing the SAS Activity-Based Management installation you may rebuild the SAS OLAP 

Server cubes using SAS Activity-Based Management 7.2. 

Migrating from SQL Server 2000 or 2005 

SAS recommends that users who want to upgrade to a newer version of SQL Server and who must 

do this with a single database computer follow the following steps: 

 Backup you existing SQL Server data 

 Detach the databases to be migrated and save the generated tables 

 Uninstall the existing SQL Server version 

 Install the new SQL Server version 

 Re-attach the saved tables 

 If migrating from SAS Activity-Based Management 6.x or 7.1, update your databases to the 

7.2 format/schema (see Chapter 8) 

This procedure for backing up SQL Server data and moving data between SQL Server versions is 

documented at Microsoft’s website for SQL Server 2005 at: http://support.microsoft.com/kb/224071 

and here for SQL Server 2008: http://msdn.microsoft.com/en-us/library/ms345408.aspx. 

Tip: Before installing the new version of SQL Server SAS recommends that a new operating system 

disk image be installed with the latest service packs. This ensures the smoothest possible 

migration. 

Migrating From Microsoft Analysis Services 2000 

Based on tests at SAS, Microsoft’s tool for migrating Microsoft Analysis Services 2000 (MSAS) cubes 

to a Microsoft SQL Server Analysis Services 2008 (SSAS) OLAP server may encounter numerous 

problems from which there is no recovery. Since the time spent on this process is very large 

(processing the cubes on MSAS 2000, migrating the cubes to SSAS 2008, and then reprocessing the 

cubes on SSAS) and may not be successful, SAS does not recommend this and does not support the 

Microsoft cube migration process for SAS Activity-Based Management. 

In order to leave the existing MSAS 2000 cubes on the SAS Activity-Based Management 6.x database 

and not migrate them to SSAS 2008, you do not need to perform any additional steps. The steps 

http://support.microsoft.com/kb/224071
http://msdn.microsoft.com/en-us/library/ms345408.aspx
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outlined in the previous section “Migrating from SQL Server 2000” will only migrate the SAS 

Activity-Based Management model data – not any of the Microsoft cubes. If you installed a “clean” 

version of SSAS 2008 for use by SAS Activity-Based Management 7.2, it will not have any of your old 

cubes present. 

SAS recommends that the MSAS 2000 cubes not be migrated to SSAS; instead they should be rebuilt 

natively in the SSAS environment using SAS Activity-Based Management 7.2. 

Migrating From Microsoft Analysis Services 2000 or 2005 

If your installation of SAS Activity-Based Management contains a large number of cubes or a small 

number of very large cubes, you may find that they exceed the capacity of a 32 bit version of SSAS – 

even though they fit comfortably in a 32 bit version of MSAS. There are at least three steps to take to 

mitigate this problem: 

 Enable the Microsoft “3GB mode” 

 Optimize the configuration settings of your SSAS instance 

 Use a 64 bit version of SSAS  

The first step, enabling the “3GB mode” may be necessary because it appears that SSAS uses system 

memory resources less efficiently than MSAS. Enabling the “3GB mode” increases the system 

memory available to SSAS from 2GB to 3GB. In situations where SSAS is managing many cubes or 

large cubes, enabling this option often increases performance and capacity. 

Secondly, optimizing your SSAS settings may also be necessary. When installed, SSAS uses default 

settings for how much memory to reserve for its use, how it performs aggregations, etc. Many of 

these settings can be customized to increase performance or capacity on your particular hardware 

configuration. 

Finally, switching to a 64 bit version of SSAS (and SQL Server as well) that runs on a 64 bit operating 

system may also improve performance. This happens because 64 bit applications can access more 

than the 4GB of memory that limits 32 bit applications. Please be aware however, that simply 

installing a 64 bit version of the software on your existing hardware might not produce noticeable 

performance or capacity gains. This happens because both 32 and 64 bit version of SSAS initialize 

many settings based upon your hardware configuration. Without any custom configuration, both 

versions may create the same default settings that produce identical, or nearly so, behavior on the 

same hardware. 

For more information on all these topics, please refer to the Microsoft document SQL Server 2008 

Analysis Services Performance Guide at http://msdn.microsoft.com/en-us/library/dd542635.aspx. The 

chapter “Increasing Available Memory” is particularly useful. 

Migrating Cubes 

At this point in the migration process, you have cleaned up the physical cubes and, if using SAS 

OLAP, any of the metadata for those cubes as well. 

However, SAS Activity-Based Management also stores a small amount of data about the cubes as 

well so it can display which cubes are available for viewing. This data also needs to be removed. 

Unfortunately, this step is not performed automatically as part of the database upgrade process in 

Chapter 8. Instead, you must manually run two queries from your database management application. 

http://msdn.microsoft.com/en-us/library/dd542635.aspx
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Tip: When you re-create your cubes using SAS Activity-Based Management 7.2, your saved OLAP 

Views will automatically access the new cubes. 

Microsoft SQL Server 2000 and 2005 

1. Launch the SQL Server Management Studio application from the Start menu. 

2. Log in using your SAS Activity-Based Management database credentials. Make sure that the 

Server type option is set to Database engine. The log in user can be the SQL Server database 

user you created for SAS Activity-Based Management 6.x to access the database. 

3. Expand the root folder. Expand the Databases folder as well. 

4. Select the OEModels folder or the folder representing the name you gave the SAS Activity-

Based Management 6.x models database. 

 

5. Right-click the OEModels folder and select New Query. The right-hand side of the SQL 

Server Management Studio application becomes a query entry window. 

6. Paste the following two queries into the query window and select the Execute button on the 

toolbar or Query menu: 

delete from WorkspaceNode where ObjectId in (select id from 

WorkspaceObject where Type = 34); 

delete from WorkspaceObject where Type = 34; 

7. Close the SQL Server Management Studio application. You do not need to save the 

temporary queries you entered. 

Oracle 10g 

1. There are several Oracle tools you can use to execute the queries. These instructions represent 

one possible way. Launch the Oracle SQL Developer application. 

2. Either expand the proper connection in the left-hand pane, if you have already one to your 

SAS Activity-Based Management 6.x models schema, or create a new connection if necessary. 

Once you have a proper connection opened, the top-right pane in the Oracle SQL Developer 

application is the query window.  

3. Paste the following two queries into the query window and select the Run script button on 

the toolbar: 

delete from WorkspaceNode where ObjectId in (select id from 

WorkspaceObject where Type = 3 
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delete from WorkspaceObject where Type = 34 

4. Close the Oracle SQL Developer application. 
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Appendix E – Debug Configuration Guide 

This appendix deals with changing logging properties. This is an advanced topic and is typically 

used with the guidance of SAS Technical Support to monitor your SAS Activity-Based Management 

installation. 

Logging 

SAS Activity-Based Management 7.2 provides logging for the server applications as well as the server 

diagnostic.  

Server Logging 

The web logging is controlled by the SASActivityBasedManagement-log4j.xml file in the 

configuration directory you chose. 

Windows:  <CONFIGHOME>\Web\Common\LogConfig 

UNIX:   <CONFIGHOME>/Web/Common/LogConfig 

The log named SASActivityBasedManagement7.2.log resides in the configuration directory you 

chose.  

Windows:  <CONFIGHOME>\Web\Logs 

UNIX:   <CONFIGHOME>/Web/Logs 

“Out of Process” Logging 

The SAS Activity-Based Management operations that execute outside the web application server’s 

JVM (model import, model export, and calculation/cube generation) create log files. Logging is 

controlled by the AbmOutProcOperationLog4j.properties file located at:  

Windows:  <CONFIGHOME>\Applications\SASActivityBasedManagement7.2\config 

UNIX:   <CONFIGHOME>/Applications/SASActivityBasedManagement7.2/config 

The log file is that is produced is named <TypeOfOperation>_GUID.log, where 

<TypeOfOperation> is DataImport, DataExport, and Algo for import, export, and 

calculation/cube generation respectively. The GUID is a unique ID generated internally to identify 

each instance of an operation. 

Server Diagnostic Logging 

The server diagnostic logging is controlled by the log4j.properties file located in the directory: 

Windows:  <SASHOME>\SASActivityBasedManagementServer\7.2\diagnostic 

UNIX:   <SASHOME>/SASActivityBasedManagementServer/7.2/diagnostic 

It is initially set to warn. The log will go into the same directory and be named 

sas.solutions.abm.server.diagnostic.log.   
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If you are a Windows Vista user, you will need to change the log4j.appender.file.File 

parameter to include a directory outside of the Program Files directory. Update the line: 

log4j.appender.file.File=C:\<MyDirectory>\sas.solutions.abm.server.diagnos

tic.log  
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